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This is the wiki manual for GRAMPS version 3.3. All users are en-
couraged to edit this manual to help improve its readability and usabil-
ity.

Special copyright notice: All edits to this page need to be
under two different copyright licenses:
• GNU Free Documentation License 1.2 - see wiki

copyright
• GPL - see manual copyright

These licenses allow the Gramps project to maximally use
this wiki manual as free content in future Gramps versions.
If you do not agree with this dual license, then do not edit
this page. You may only link to other pages within the wi-
ki which fall only under the GFDL license via external
links (using the syntax: [http://www.gramps-project.org/
...]), not via internal links.
Also, only use the known conventions

Abstract
The GRAMPS Manual details all aspects of the GRAMPS software
application.
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Gramps 3.3 Wiki Manual - Preface

GRAMPS is a software package designed for genealogical research.
Although similar to other genealogical programs, GRAMPS offers
some unique and powerful features which we’ll discuss below.

GRAMPS is an Open Source software package, which means you
are free to make copies and distribute it to anyone you like. It’s devel-
oped and maintained by a worldwide team of volunteers whose goal is
to make GRAMPS powerful, yet easy to use.

Special copyright notice: All edits to this page need to be
under two different copyright licenses:
• GNU Free Documentation License 1.2 - see wiki

copyright
• GPL - see manual copyright

These licenses allow the Gramps project to maximally use
this wiki manual as free content in future Gramps versions.
If you do not agree with this dual license, then do not edit
this page. You may only link to other pages within the wi-
ki which fall only under the GFDL license via external
links (using the syntax: [http://www.gramps-project.org/
...]), not via internal links.
Also, only use the known conventions

Previous Index Next

Why use GRAMPS?
Most genealogy programs allow you to enter information about your
ancestors and descendants. Typically, they can display family relation-
ships through charts, graphs, or reports. Some allow you to include
pictures or other media. Most let you include information about people
even if those people are not related to the primary family you happen
to be researching. And they may include features that let you exchange
data with other programs and print different types of reports.

GRAMPS has all these capabilities and more. Notably, it allows
you to integrate bits and pieces of data as they arise from your research
and to put them in one place -- your computer. You can then use your
computer to manipulate, correlate, and analyze your data, rather than
messing with reams of paper.

Typographical conventions
In this book, some words are marked with special typography:
• Applications
•

Commands you type at the command line

• Filenames
• Replaceable text
• Labels for buttons and other portions of the graphical interface
• Menu selections look like this:
• Buttons you can click
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• Anything you type in
The manual also provides assorted bits of additional information in
tips and notes as follows:

Example Tip
Tips and bits of extra information will
look like this.

Example Note
Notes will look like this.

Finally, there are warnings, notifying you where you should be care-
ful:

Example Warning
This is what a warning looks like. If
there’s a chance you’ll run into trouble,
you will be warned beforehand.

Previous Index Next
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Gramps 3.3 Wiki Manual - What’s new?

Special copyright notice: All edits to this page need to be
under two different copyright licenses:
• GNU Free Documentation License 1.2 - see wiki

copyright
• GPL - see manual copyright

These licenses allow the Gramps project to maximally use
this wiki manual as free content in future Gramps versions.
If you do not agree with this dual license, then do not edit
this page. You may only link to other pages within the wi-
ki which fall only under the GFDL license via external
links (using the syntax: [http://www.gramps-project.org/
...]), not via internal links.
Also, only use the known conventions

Previous Index Next

This section gives an overview of changes since version 3.2. These
changes are also detailed later in this manual. Users of version 3.2 are
encouraged to review this section to be sure to take advantage of these
new features.

Before you upgrade
Warning
Creating an archive alone to safeguard
your data might not be appropriate be-
fore upgrading. In the unlikely event
that Gramps 3.3 corrupts your database,
it could also corrupt the archive. An ex-
port as outlined in this section is recom-
mended.

Before you upgrade, make sure your family tree data is secure. The
best way to do this is:
1. Start Gramps 3.2
2. Open your family tree
3. Export the family tree to the gramps xml format or the gramps

xml package format (which includes your photographs and other
media files associated with your family tree data). Export your
tree via menu Family Trees->Export, making sure you export all
data with no filters applied.

4. Close this family tree and repeat the above steps for any other
family trees you have

5. Keep the resulting file(s) in a safe place
For more information, please review Backing up a Family Tree.

After properly safeguarding your data, proceed to install Gramps 3.3.
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Use your operating system’s regular installation process to do this. It
is also best to uninstall Gramps 3.2 before installing Gramps 3.3, or
make sure you install Gramps 3.3 in a different location.

After you install Gramps 3.3, you can open your existing family
trees and continue working. In case of problems (e.g., after a complete
system upgrade), use the backup file(s) created above to recreate your
family tree(s).

Warning
Once you open a family tree in a newer
version of Gramps or using a newer op-
erating system, you generally should not
try to open that database using an older
version again. As always, the gramps
xml format is the format to use for the
interchange of your data in such cases.
There are tools to repair broken databas-
es, but they are for expert users, so
avoid needing them by following the
steps above before you upgrade your OS
or Gramps.

Visible changes to the core
Names
• Formats
• New Editor
• New filter rules

GrampsBar
A sidebar and bottombar are available on all views except for the
Gramplet View. They allow gramplets to be displayed alongside a
view.

See Gramplets for more details.

Tags
Tags replace Markers. Tagging is available for Person, Family, Media
and Note objects. Users can tag an object with multiple tags.

Merging
All primary objects could now be merged.

See Merging Records for more details.

Locality
A Locality field has been added to Location between the Street and
City fields.

New Selection Dialog in Export
When exporting your data, you now have a fine-grained control over
the details of how filters can be applied. You also can now check
which records are selected (and which ones are not) through this inter-
face.

More tooltips
All fields on Editors have now tooltips.
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Linking in Notes
Notes now support links to other items in Gramps. For example, when
writing a note, you can put a link to a person, family, or marriage.
When viewing these notes, you can quickly click on the link and bring
up the object.

Links are also converted to HTML links when, for example, run-
ning the Narrative Web report.

Backup dialog
Simply select "Make Backup..." from the "Family Trees" menu item.

You can either choose to include the media or not.
Note that this is just a regular XML export, except that no data is

filtered out. You can import these as usual with any exported file.
You can also define the pattern for the backup filename by setting

the paths.quick-backup-filename in the ~/.gramps/gramps33/
gramps.ini key file like the following:

[paths]
quick-backup-filename=’%(filename)s_%(year)d-%(month)02d-%(day)02d.%(extension)s’

You can use any of the following keywords in the pattern: year,
month, day, hour, minutes, seconds, filename, extension.

Plugins changes
Views
• Pedigree view

More: Pedigree View
• GeoView

More: GeoView

Automatic update for Addons
Gramps now supports a method for automatically checking for updat-
ed Addons. You can control what and how often it checks for new and
updated addons.

These settings are controlled in Preferences.
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News
• • "Image Metadata Gramplet" now works with pyexiv2-0.1.3

and above

Reports
• Draw reports
• Substitution Keys
• Alternate Numbering on Descendant report [1]
• CLI
• Book
• Web stuff
• Improvements on Place report
• StringOption separated from GUI widget [2]
• Records report and gramplet [3]

Under the hood changes
Database
There were three changes to the database file structure:
1. Added a new field "locality" to the Place schema
2. Added surnames to the Name schema

• surnames is a list of surnames
• prefix and patronymic are moved to the surname

3. Replaced Markers with Tags
• marker removed from all
• tags added to Person, Media, Family, and Notes

• Transaction
• Merging
• New DB version; and XML DTD (1.4.0) [4]

• Improvements on Import/Export file formats (vcard, gedcom,
xml)

Dependencies
• python 2.6 and later
•

Optional
• exif
• pyexiv2-0.1.3, pyexiv2-0.2.2, or pyexiv2-0.3.0
•

Performances
• Improvements (memory leaks) [5]
• time for XML import
• Speed up on gramplets (pedigree)

Localisation
• New translations: Ukrainian, Portuguese from Portugal
• Lang selector on Detailed textual reports
• Holidays on Calendar reports
• Improvements on some Date handlers
• Better translation on some addons
• cleanup (configure, makefiles)
• Better support for win32/64 API

Cleanup
...
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Further info
TODO: need to update above content with:

See the 3.3.0 roadmap, the change log and Roadmap.
• Additional Name Fields [6][7]
• Tagging
• Place handling
• Database (XML /part of GEPS016/, transaction, merging /part of

GEPS009/)
• Sidebar/bottombar [8]
• New Individual Editor [9][10]
• Geography
• Enhanced Pedigree View [11] and support ’config’ on views into

ancestry category [12].
• Substitution Keys
• Draw reports: Ancestor3.3, Descendant3.3, Page_size3.3
• Exporter has added control of filters and proxies; also has method

for seeing intermediate results along the filtering process
• New simple backup option on menu
• New gramplets and performance improvements (Pedigree

gramplet)
• Url style on Note object (internal uri)
• Automatic check for update (Addons)
• New filter rules
• Complete tooltips on editors and manual
• Use language selector on detailled reports, enhancement on place

report, translated holiday names, numbering system alternatives
on descendant report [13], better support for win32/mac
packages, cleanup, need python 2.6 or later, new translations
(Ukrainian, Portuguese from Portugal), etc ...

Previous Index Next
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Gramps 3.3 Wiki Manual - Getting started

In this chapter, we’ll begin with the basics. We’ll show you how to
start GRAMPS and how to get help when you need it.

Special copyright notice: All edits to this page need to be
under two different copyright licenses:
• GNU Free Documentation License 1.2 - see wiki

copyright
• GPL - see manual copyright

These licenses allow the Gramps project to maximally use
this wiki manual as free content in future Gramps versions.
If you do not agree with this dual license, then do not edit
this page. You may only link to other pages within the wi-
ki which fall only under the GFDL license via external
links (using the syntax: [http://www.gramps-project.org/
...]), not via internal links.
Also, only use the known conventions
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Start GRAMPS
If you installed Gramps via one of the installation packages, an entry
for Gramps will have been created in the Application menu. In Linux
Gramps is normally installed in the Office section.

Command line use
Like many applications that started on
Linux, Gramps allows command line op-
eration, allowing you to create reports, do
conversion, ..., without opening a win-
dow. Command line use of Gramps can
also help to fix problems, as extra infor-
mation is printed in the terminal window.
To start Gramps like this, type in a termi-
nal:

gramps

and then pressing Enter. For more in-
formation, see the Command Line appen-
dix.
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Choosing a Family Tree

Fig.1.1 Initial window

If GRAMPS is started without a family tree selected, the initial screen
will have little functionality. Most operations will not be available. To
load a family tree (also referred to as database), select in the menu
Family Trees->Manage Family Trees to open the family tree man-
ager, or click the Family Tree icon in the toolbar. Gramps keeps track
of your recently opened Family Trees, and these can be selected by
clicking on the arrow next to the Family Tree button and choosing
from the drop down menu.

For more detailed information on the Family Tree manager and the
Family Trees menu, see the chapter dedicated to this: Manage Family
Trees.

Tell me how to start right now!
We advise everyone to read/go over the manual to learn all the details
of Gramps. Genealogy takes time, so learning the tools is not wasted
time.

However, if you really want the bare minimum to start, then read
this How-To start with Genealogy using Gramps.

Obtaining Help
GRAMPS has a Help menu that you can consult at any time. It in-
cludes the following items:
• User manual: An link to this manual. Yes, at the moment you

need an internet connection to consult the Gramps Manual
• FAQ: A link to the Frequently Asked Questions about Gramps.
• Tip of the day: Displays the "Tip of the day" dialog.
• Plugin status: Use this item to display the status of any plugins

you may have added.
• GRAMPS home page: This item opens your web browser and

connects to the Gramps’ project web site.
• GRAMPS mailing lists: This item opens your web browser to the

Gramps mailing list page. At this page, you can browse the
mailing list archives or join the gramps-users mailing list.

• Report a bug: Choose this item to file a bug report in our bug
tracking system. (Remember, Gramps is a living project. We
want to know about any problems you encounter so we can work
to solve them for everyone’s benefit.)

• About: This item displays a dialog with general information about
the Gramps version you are running.

Previous Index Next
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Special copyright notice: All edits to this page need to be
under two different copyright licenses:
• GNU Free Documentation License 1.2 - see wiki

copyright
• GPL - see manual copyright
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Introduction

Fig. 2.1 GRAMPS Main Window

When you open a database (either existing or new), the following win-
dow is displayed:

The main GRAMPS window contains the following elements:
• Menubar: The menubar is located at the very top of the window

(right below the window title) and provides access to all the
features of GRAMPS.

• Toolbar: The toolbar is located right below the menubar. It gives
you access to the most frequently used functions of GRAMPS.
You can set options that control how it appears by going to . You
can also hide it entirely by going to View ->Toolbar.
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• Progress Bar: The Progress Bar is located in the lower left corner
of the GRAMPS window. It displays the progress of time
consuming operations, such as opening and saving large
databases, importing and exporting to other formats, generating
web sites, etc. When you are not doing these types of operations,
the Progress Bar is not shown.

• Status Bar: The Status Bar is located to the right of the Progress
Bar, on the very bottom of the GRAMPS window. It displays
information about current GRAMPS activity and contextual
information about the selected items.

• Display area: The largest area in the center of the GRAMPS
window is the display area. What it displays depends on the
currently selected View. We’ll discuss Views in detail below.

The different Categories
Genealogical information is very broad and can be extremely detailed.
Displaying it poses a challenge that GRAMPS takes on by dividing
and organizing the information into a series of Categories, each with
their own Views. Each View displays a portion of the total informa-
tion, selected according to a particular category. This will become
clearer as we explore the different Categories:
• Gramplets: Displays different Gramplets, small widgets that can

help in your genealogical research.
• People: Displays the people in the family tree without their

connections. This Category contains the PeopleListView and the
PeopleTreeView.

• Relationships: Shows the relationships between the Active Person
and other people in a textual way. This includes parents, spouses,
and children.

• Family: Shows the families in the family tree.
• Ancestry: Displays graphical trees for the selected person.
• Events: Displays the events in the family tree.

• Places: Displays the places in the family tree.
• Geography: Displays data of your family tree on a map.
• Sources: Displays the sources in the family tree.
• Repositories: Displays the repositories in the family tree.
• Media: Displays the media objects in the family tree.
• Notes: Displays the notes in the family tree.

The categories can contain several ways of presenting the data. Each
specific way is called a View. Before we launch into a description of
each View, let’s first explain how to switch between Views.

Switching Views and Viewing Modes

Fig. 2.2 Sidebar view mode

As mentioned above there are 12 different Categories, but plugins you
download may create new categories. There are two different Viewing
Modes. You can tell at a glance which Viewing Mode you are in: If
you see icons listed vertically in a sidebar at the left of the window,
you are in the Sidebar Viewing Mode.
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If you’re in the Sidebar Viewing Mode, you can select the Catego-
ry you want by clicking one of the sidebar icons.

Furthermore CTRL+P and CTRL+N go to previous or next cate-
gory.

As said, a category can contain different ways of presenting the
data, called a View. If there are several views, you can switch between
the views on the toolbar as each view will have an icon button. You
can also switch via the menu View, or by pressing CTRL+<num-
ber> , where <number> is the view you want in this category.

Gramplets Category

Fig.2.4 Gramplets view

This contains the Gramplet View, which shows a number of widgets,
called Gramplets, that can help you in your research. Two Gramplets
are shown on start-up (the Welcome and Top Surname Gramplets), but
by right-clicking on the view, a popup comes up with the possibility
of adding other Gramplets.
• Age on Date Gramplet - see the people alive and their ages on a

particular date
• Age Stats Gramplet - see age span graphs
• Attributes Gramplets - see active person’s attributes
• Calendar Gramplet - see people’s events on a particular date, or in

a month in the past
• Descendants Gramplet - see the active person’s descendants
• Fan Chart Gramplet - see the active person’s pedigree, in a

circular fan chart
• Given Name Cloud Gramplet - most popular given names
• Pedigree Gramplet - see a complete pedigree in compressed text
• Quick View - run a Quick View on the current person
• Records Gramplet - see world’s records of your data
• Relatives Gramplet - see the relatives of the active person
• Session Log Gramplet - keep track of what you have done, and

what records you have visited
• Statistics Gramplet - see stats on the database
• Surname Cloud Gramplet - most popular surnames as a "text

cloud"
• TODO Gramplet - a notepad to keep tabs on your research
• Top Surnames Gramplet - top 10 most popular surnames
• Welcome Gramplet - a GRAMPS welcome message
• What’s Next Gramplet - what needs to be done next

In addition, there are a number of additional Gramplets that you can
easily install and use. These include:
• Headline News Gramplet - current, breaking news from

GRAMPS
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• Data Entry Gramplet - edit active person’s name, birth date and
place, death date and place, and add people

• Python Gramplet - a Python shell
• FAQ Gramplet - frequently asked questions
• Note Gramplet - see and edit active person’s primary Person Note

and many others. See Third-party Plugins for more details.
For more detailed information on using the installed Gramplets,

see Gramplets.

People Category
TreeView and ListView

Fig. People ListView

Fig. People TreeView
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Configuration

Fig. 2.5 Column Editor Dialog

The People View lists the people stored in the database. You’ll note
that people are grouped according to their family names. To the left
of each family name is typically either an arrow or some other type of
indicator. Clicking it once will reveal the entire list of people sharing

that name. Clicking the indicator again will "roll up" the list and show
only the family name.

By default, the People View, displays several columns of informa-
tion about each person. You can add or remove columns to and from
the display by calling up the Column Editor dialog (View -> Config-
ure... or click on Configure button) and checking or unchecking the
boxes listed. You can also change the position of a column in People
View by clicking and dragging it to a new position in the Editor (drag
and drop). Once you have made the changes you want, click OK to
exit the Editor and see your changes in the People View.

Column Editor
The Column Editor is available in all
Views and works the same way in each.
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Filters

Fig. 2.6 Filter Controls Displayed

Genealogical databases can contain information on many people, fam-
ilies, places, and objects. It’s therefore possible for a View to contain
a long list of data that’s difficult to work with. GRAMPS gives you
two different means for controlling this condition by allowing you to
filter a list to a more manageable size.

These methods are Search and Filtering.
A search will search the text displayed in list, whereas filters dis-

play people whose data match the criteria of the filter. Search is a sim-
ple but fast method of searching the columns displayed on the screen.
Typing the characters into the Search box and clicking the Find button
will display only lines that match the text.

Alternatively, you can enable the Filter sidebar , which will be
displayed on the right hand side of the display. When the filter sidebar

is displayed, the Search bar is not displayed. The Filter side bar al-
lows you to interactively build a set of filter rules that can be applied
to the display. The filter is applied based on the rules and the data, not
on the screen display.

Searching vs. Filtering
Searching only searches for exact text
matches. If the date displayed is "Jan 1,
2000", a search of "1/1/2000" will fail,
but a filter of "1/1/2000" will match.

When GRAMPS opens a database, no filtering is in effect. In People
View, for example, all people in the database are listed by default.

Sorting columns

Fig. Sort Column

To be written.
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Relationships Category

Fig. 2.7 Relationships View

The Relationships View displays all the relationships of the Active
Person (the selected person). Specifically, it shows his or her parents,
siblings, spouses, and children.

The Relationships View is designed to allow for quick navigation.
You can quickly change the Active Person simply by clicking the
name of any person listed on the page. Each name is actually a hyper-
text link, similar to a web page.

The name of the Active Person is in bold style. Other names are
shown either with or without bold and italic emphasis depending on
whether certain relationships exist for the named person. For a person
listed as a parent or spouse of the Active Person, the name is empha-
sized if that person has a parent family. For a person listed as a sibling
or child of the Active Person, the name is emphasized if that person
has children.

Dates are normally in regular style, and in italic style if the dis-
played event is a fallback event, i.e., a substitute event for another

missing event. That may be christening event for birth event, burial
event for death event, etc.

The Relationships View displays the following sections:
• Active Person: At the top of the screen, name, ID, birth, and

death information, calculated age of the Active Person is
displayed. If a photo of the person is available, it is shown on the
right hand side. Next to the person’s name is a symbol indicating
gender, and an Edit button. Clicking the Edit button will allow
you to edit all of the person’s individual information in an Edit
Person dialog.

• Parents: The next section, the Parents section, displays the
families in which the person is a child. Since it is possible for a
person to have multiple sets of parents, it is possible to have
several Parents sections.

You can control how much information is displayed by using the View
menu. The view menu allows you to show or hide details (the birth
and death information) and to show or hide siblings. Next to each per-
son listed is an Edit button, which will allow you to edit all the details
of that particular person.

You may add a set of parents by either selecting the Add Parents
or the Share Parents buttons. The Add Parents button will create a
new family with the Active Person listed as a child. The Share Par-
ents button will allow you to choose from a list of existing families,
and then add the person as a child to that family.

You may edit an existing parents by selecting the Edit button next
to the parents. If you select the Delete button next to a set of parents,
then the Active Person will be removed as a child from the parents.
This button does not delete the parents’ relationship.

Warning
If you are not careful, it is possible to
create multiple families with the same
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parents. This is rarely what the user
wants to do. If you attempt to add a new
family that has the same parents as an
existing family, GRAMPS will issue a
warning dialog. If you get this dialog,
you should probably Cancel the edit,
and then use the Select button to select
the existing family.

• Family: Similar to the Parents section is the Family section,
which displays families where the Active Person is a parent.
Because it is possible to have multiple families, it is possible to
have multiple Family sections. Each family section displays the
spouse and any children.

Spouse
We use the term spouse for sake of sim-
plicity. However, please note that spouse
may in fact be a domestic partner, a part-
ner in a civil union, or various other simi-
lar relationships between two people.
Spouse relationships are not required to
be only between a male and female.

Fig. 2.8 Relation reordering

You may add a family by selecting the Add Spouse button in the
toolbar. This will create a new family with the Active Person listed as
a father or mother.

Selecting the Edit button next to the spouse will allow you to edit
the displayed family. Clicking the Delete button will remove the per-
son from the displayed family.

Removing a person from a family
Removing a person from a family does
not delete the family. The person is re-
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moved as the father or mother, and any
other relationships in the family contin-
ue to exist.

Note
We use the terms father and mother for
the sake of simplicity. Even if there are
no children in a family, the father and
mother terminology is still used. In the
case of male/male or female/female rela-
tionships, the father and mother labels
should be considered to be convenience
labels.

You can reorder the parents and spouses by selecting the Reorder but-
ton. This option will only be enabled if more than one set of parents
or more than one set of spouses exists for the Active Person. Selecting
this button will display a dialog that will allow you to reorder the fam-
ilies.

Configuration

Fig. Configure Relationships View

You can configure the view from the display by calling up the Con-
figure dialog (View -> Configure... or click on Configure button).

Families Category

Fig. 2.9 Family List View

The Family List View displays a list of all families in the database.
From this view, you may add, edit, or delete families. The default dis-
play lists the ID, Father, Mother, and Relationship. Children cannot be
displayed on the screen in this view.

Remove button
Unlike the Relationships View, clicking
the Remove button in this view will re-
move the family from the database. All
people will remain, but all relationships
between the people in the family will be
removed.

From Gramps Gramps 3.3 Wiki Manual - Main Window

9

wiki/index.php?title=File:Gramps-notes.png
wiki/index.php?title=File:Gramps-notes.png
wiki/index.php?title=File:Configure_RelView.png
wiki/index.php?title=File:Configure_RelView.png
wiki/index.php?title=File:Family_List.png
wiki/index.php?title=File:Family_List.png
wiki/index.php?title=File:Gnome-important.png
wiki/index.php?title=File:Gnome-important.png


Ancestry Category
The Ancestry Category shows several graphical representations of the
ancestry of the active person. By default this is the Pedigree View and
the Fan Chart View, but the addons contain extra downloadable views.

Pedigree View

Fig. 2.10 Pedigree view 1

Fig. 2.11 Pedigree view layout
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Fig. 2.12 Pedigree view 2

Fig. 2.13 Pedigree view 3

Fig. 2.14 Pedigree view 4
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Fig. 2.15 Children menu

The Pedigree View shows up to five generations, depending on the
size of the window. Each person is indicated by a box labeled with
his or her name, birth and death information, and optionally an image
if available. Two lines branch from each box. The top one shows the
person’s father and the bottom one the mother. Solid lines represent
birth relations, while dashed lines represent non-birth relations such as
adoption, step-parenthood, guardianship, etc.

To the left of the Active Person is a left arrow button. If the Active
Person has children, clicking this button expands a list of the Active
Person’s children. Selecting one of the children makes that child the
Active Person.

The appearance of the children’s names in the menu differentiates the
dead ends of the tree from the continuing branches.

Children who have children themselves appear in the menu in the
boldface and italic type, while children without children (dead ends)
appear in a regular font. If the Active Person has only one child, no
menu will be displayed (since there is only one choice) and the child
will become the Active Person when the arrow button is clicked.

The right-hand side of the window shows two right arrow buttons.
When the top button is clicked, the Father of the Active Person be-
comes the Active Person. When the bottom button is clicked, the
Mother of the Active Person becomes the Active Person.
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Fig. 2.16 Personal context

Right-clicking on any person’s box in the Pedigree View will
bring up the "context menu".

Among other useful items, the context menu has sub-menus listing
Spouses , Siblings , Children , and Parents of that person.

"Greyed-out" sub-menus indicate the absence of the data in the ap-
propriate category. Similar to the children menu above, Childrens’ and
Parents’ menus distinguish continuing lines from dead ends.

Fan Chart View

Fig. 2.17 Fan Chart View

This view shows the ancestry but as a pie chart. Clicking on a name
in the chart will double the section of the pie allocated to that person.
A second click brings the chart back to the original form. Right click
brings up a context menu like in the pedigree view, allowing to navi-
gate to other people.
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This view enables to see large ancestries in a more compact man-
ner, and to see very quickly which parts of an ancestry need further
research.

You can rotate the view by click and drag outside the fan chart.
You can move the view by click and drag inside the inner (white) re-
gion.

Events Category

Fig. 2.18 Events view

Events can be shared between multiple people and multiple families.
The Events View lists the all the events recorded in the database.

The columns available for display are: Description , ID , Type ,
Main Participants , Date , Place and Last Changed .

The default view displays the Description , ID , Type , Date and
Place of the event. The Column Editor dialog can be used to add, re-
move and rearrange the displayed columns. This can be accessed from
the Configure View... button on the toolbar.

Meaningful event description
Because events can be shared, you
should take the extra time to give each
event a unique and meaningful descrip-
tion. This will help you find the correct
event if you decide to share events.

The list of Events can be sorted in the usual manner, by clicking on
the column heading. Clicking once sorts in ascending order, clicking
again sorts in descending order.

Sources Category

Fig. 2.19 Sources view

From Gramps Gramps 3.3 Wiki Manual - Main Window

14

wiki/index.php?title=File:Events.png
wiki/index.php?title=File:Events.png
wiki/index.php?title=File:Gnome-important.png
wiki/index.php?title=File:Gnome-important.png
wiki/index.php?title=File:Sources.png
wiki/index.php?title=File:Sources.png


Sources View lists the sources of certain information stored in the
database.

These can include various documents (birth, death, and marriage
certificates, etc.), books, films, journals, private diaries, - nearly any-
thing that can provide genealogical evidence. GRAMPS gives you the
option to provide a source for each event you record (births, deaths,
marriages, etc.). The Sources View lists the Title , ID , and Author of
the source, as well as any Publication information that may be asso-
ciated with it.

The list of Sources can be sorted by clicking on a column heading.
Clicking once sorts in ascending order, clicking again sorts in de-

scending order. The Column Editor dialog can be used to add, re-
move and rearrange the displayed columns.

Places Category

Fig. 2.20 Places view

The Places Views lists the geographical places in which the events
of the database took place. These could be places of birth, death, and
marriages of people, as well as their home, employment, education ad-
dresses, or any other conceivable reference to the geographical loca-
tion. The Places View lists the places’ Name , ID , Church Parish
, City , County , State , and Country . All of these columns can be
used for sorting by clicking on a column heading.

Clicking once sorts in ascending order, clicking again sorts in de-
scending order. The Column Editor dialog may be used to add, re-
move and rearrange the displayed columns.

If a place has been highlighted, you may select the Google Maps,
loading... button to attempt to display the place in a web browser. The
map service can be chosen from the drop down list under the black tri-
angle to the right of the map button.

Your default web browser should open, attempting to use either
the longitude and latitude coordinates or the place name to display
the location using the Google Maps web site. Different map services
might have different requirements for the location description.

This feature is limited, and may not always produce the results you
desire.
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PlaceTreeView and PlaceListView

Fig. 2.21 Places TreeView

Fig. 2.22 Places ListView

The two views in this category show the places grouped or ungrouped.
The PlaceTreeView tries to group the places in logical groups: coun-
try, county, ... . This view is new in version 3.3.0. In future versions
the aim is to make the grouping more intelligent.

The PlaceListView on the other hand just shows all the places in
one long list.

Geography Category
This category is for showing data on a map. It contains the Geographic
View, which allows you to see the people and their events placed on a
map via an internet map provider (OpenStreetMap or Google maps).
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Fig. 2.23 Geographic View

The Geographic View can:
• show all places in your family tree
• show a filtered selection of places
• show all places connected to the active person
• show all places connected to the active family
• show all places connected to all events
• show all places connected to a filtered selection of events

These options are accessible via the buttons on the toolbar. To filter
on places or events, activate the filter sidebar (View->Filter Sidebar)

Furthermore, the Geographic view can help you add new places
to your family tree, or add latitude-longitude coordinates to existing

places. To activate this, use the add location button, or the link loca-
tion button in the toolbar.

The top of the Geographic View shows two lines with information,
allowing you to change the information shown. The second line al-
ways shows in bold what is shown on the map. The first line has:
• Place list button and selection field.

The button shows how many places are present in the map. The
selection fields allows you to jump to one of these places. You
can clear the selection field by clicking the places list button.

• Place page buttons
If there are many places, the map is no longer useful because too
much information is shown. Therefore, the places will be
divided in pages. You can navigate the pages and see the map
change via the Place page buttons: << goes back a page, >> goes
forward a page, and the middle button shows how many pages
there are and what is shown at the moment.

• Places with no latitude-longitude
The Geographic View can only show places with a valid
latitude-longitude. A list of all places that satisfy the selection,
but cannot be put on the map, is available via the button with a
number and the ? sign. You can add latitude-longitude to these
places in one of the following ways:
• Use the place link button on the Geographic View
• Go to the Place View, and use the Go button to search the

place and it’s location
• Download the Place completion tool via the Help->Plugin

Manager. If you download the data of your country, this tool
can add latitude-longitude to all your places.

• lock zoom level.
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If you zoom the map to a resolution you want to keep, then you
can press the lock zoom level button, and every time the
Geographic View redraws the map, this zoomlevel will be used.

• provider selection change
Gramps uses OpenStreetMap or Google Maps to provide the
map you see. With this button you can quickly change from one
to the other. The advantage of OpenStreetMap is that it is a free
project, so you can update the maps yourself with missing
information via their website.

Via the Configure View button in the toolbar (or in the View menu,
you have the following functionality:
• Map options

• add crosshair in center of map, usefull to add or link places
to the correct latitude-longitude coordinates

• show coordinates in the statusbar

• Time period: this changes how the view divides events in groups
• Network: This view needs an internet connection. If your

connection drops away from time to time, or is not always on,
you can set here to have the Geographic view retry the internet
connection. Like this, the Geographic view will become active
the moment your internet connection returns, without you
needing to take manual action.

Note
The Geography category is only present
if OsmGpsMap is present that Gramps
can use.

Media Category

Fig. 2.24 Media view

The Media View is a list of Media Objects used in the database.
Media Objects are any files that relate somehow to the stored ge-

nealogical data.
Technically, any file can be stored as a Media Object.
Most frequently, these are images, audio files, animation files, etc.

The list box on the bottom lists the Name , ID , Type , and Path of
the Media Object.

The Column Editor dialog may be used to rearrange the displayed
columns, which obey usual sorting rules. The top part of the GRAMPS
window shows a preview (if available) and information about the Me-
dia Object.
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Repositories Category

Fig. 2.25 Repositories view

Version 2.2 adds support for Repositories.
A repository can be thought of as a collection of sources.
Each source in the database can reference a repository (such as a li-

brary) in which it belongs. The functionality of the Repositories View
is similar to the other views.

Notes Category

Fig. 2.26 Notes view

A Note is pure text, as stored in the other objects.
The functionality of the notes View is similar to the other views.

The view lists all Notes stored in the Family Tree . With the Edit -
>Column Editor you can change the displayed columns. The possi-
bilities are Preview , ID , Type and Marker .

The Type can be (amongst others): Event Note, Address
Note,Source text, Place Note

Double-clicking on a Note in the list will bring up a window where
you can edit the Note. You can change fonts, font color and back-
groundcolor. A spellchecker is available for English and your local
language.
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HTML View (optional)

Fig. 2.27 HTML view

Fig. 2.28 online archive

HTML View (see blog) is by default hidden. You can activate it via
Help->Plugin Manager. This simple view allows to open a webpage
from within Gramps. This might be interesting if you want to access
sources on the internet without switching between Gramps and your
web browser.

Previous Index Next
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Gramps 3.3 Wiki Manual - Manage Family Trees

Now we turn to a detailed exploration of the day-to-day use of
GRAMPS. In this Chapter we give a detailed overview of how you
can manage your family trees, as well as share your data with other
genealogists.

Special copyright notice: All edits to this page need to be
under two different copyright licenses:
• GNU Free Documentation License 1.2 - see wiki

copyright
• GPL - see manual copyright

These licenses allow the Gramps project to maximally use
this wiki manual as free content in future Gramps versions.
If you do not agree with this dual license, then do not edit
this page. You may only link to other pages within the wi-
ki which fall only under the GFDL license via external
links (using the syntax: [http://www.gramps-project.org/
...]), not via internal links.
Also, only use the known conventions

Previous Index Next

Starting a new Family Tree

Fig. 3.3. Starting Family Trees

To start a new Family Tree, choose Family Trees ->Manage
Family Trees or select the Family Trees button from the toolbar. This
will open the Family Tree Manager.

Select the New button and GRAMPS will add a new Family Tree
entry to the list of Family Trees. To change its name from the default
Family Tree 1, click on the name and type in a new name.
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Now select Load Family Tree to open the new, empty Family
Tree.

Opening a Family Tree
To open a Family Tree, either choose Family Trees ->Manage Fam-
ily Trees or click the Family Trees button on the Toolbar. The Fam-
ily Tree Manager will appear and you’ll see a list of all the Family
Trees known to GRAMPS. An icon will display in the Status column
beside any Family Tree that is currently open. Select the tree you want
to open, and open it by selecting the Load Family Tree button. Alter-
natively you can double-click on the desired Tree.

To open a recently accessed Family Tree, choose either Family
Trees ->Open Recent or the down arrow next to the Family Trees
button and select the Family Tree from the list.

If you do not have "write permissions" for the selected Family
Tree, it will be opened in a Read Only mode. In this mode, the data
may be viewed, but no changes will be made to the Tree. To indicate
this mode, the title of the main window will be appended with (Read
Only) text.

Opening a GEDCOM or XML database
GRAMPS allows you to open certain databases that have not been
saved in GRAMPS’ own file format from the command line, see Com-
mand line references. These include XML and GEDCOM databases.
But you should be aware that if the XML or GEDCOM database is
relatively large, you will encounter performance problems, and in the
event of a crash your data can be corrupted. Hence, it is normally bet-
ter to create a new GRAMPS family tree (database) and import your
XML/GEDCOM data into it.

Opening databases
XML and GEDCOM databases require all
data to be held in memory and don’t con-
tain indexes. GRAMPS’ native format is
a database that only reads the data need-
ed. Thus, for a large family tree the data
can be accessed quicker and more effi-
ciently by not using XML or GEDCOM.

GEDCOM Editing
Please keep in mind that some informa-
tion in a GEDCOM file may be lost dur-
ing import into GRAMPS as well as ex-
port back to GEDCOM. Simply opening
and viewing the file will not change it.
However, if any changes were made and
they were not abandoned upon exit, ex-
iting GRAMPS will save the data, with
possible data loss.

Deleting a Family Tree
Select the family tree you want removed, and click the Delete button.

This will completely remove the tree, with no possibility to re-
trieve the data. Consider taking a backup of your data by exporting to
the GRAMPS XML format, and storing that file.

Renaming a Family Tree
You can rename a Family Tree (or an archive of it) by selecting the
tree you want to rename and clicking Rename . You can also click on
the name in the list of trees.
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In either case, you just type in the new name to have it take effect.

Backing up a Family Tree
• The safest way to backup your GRAMPS Family Tree is to

export without privacy options and filters to format (or
GRAMPS Package to include items from your Gallery) and
copy the resultant file to a safe place, preferably in a different
building.

Backup dialog
Simply select "Make Backup..." from the "Family Trees" menu item.

You can either choose to include the media or not.
Note that this is just a regular XML export, except that no data is

filtered out. You can import these as usual with any exported file.
You can also define the pattern for the backup filename by setting

the paths.quick-backup-filename in the ~/.gramps/gramps33/
gramps.ini key file like the following:

[paths]
quick-backup-filename=’%(filename)s_%(year)d-%(month)02d-%(day)02d.%(extension)s’

You can use any of the following keywords in the pattern: year,
month, day, hour, minutes, seconds, filename, extension.

• You can use the Archive feature (see next section) to store
snapshots of your tree. These snapshots can be used as simple
backups, very useful if you want to try something that you might
later want to undo. However this method should not be used for
standard backups, as it will not survive a hard disk crash or most
of the other disasters that can befall a computer.

• For advanced users: each database is stored in its own
subdirectory under ~/.gramps. A manual backup can be made by
backing up this directory.

Archiving a Family Tree
You can easily archive and timestamp family trees with GRAMPS
built-in use of GNU Revision Control System or RCS. For this to be
possible this utility must be installed on your computer.

To make an archive :
1. load your family tree.
2. click on the Family Trees button (it has the gramps logo and

displays Manage databases when you hover over it).
3. click on the family tree you’ve just loaded: the Archive button

should appear.
4. click on Archive and you will be asked for an archive name.
After archiving, the list of family trees will now show your original
family tree with a right-pointing triangle on its left.
• Click on the triangle to display the archive name.(Click again to

collapse the archive list).
Archives can be deleted, renamed and Extracted.

If you click on an archive, the Extract button becomes visible. Click
on this to obtain the extracted archive. It will appear in the family
tree list as <name of original tree>:<name of archive> and is now
an independent family tree. This can be a useful way of preserving an
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archive, because archives disappear if the originating tree is deleted;
and they are not incorporated into a Portable XML export of the tree.

Extracting a Family Tree Archive

Fig. 3.3 Selecting a version to extract

Simply highlight the archive you want to restore, and select the Ex-
tract button.

Fig. 3.3 Extracted version

GRAMPS will transfer the archive into a new Family Tree. The Fam-
ily Tree name is based on the original name and the archive name (see
also Archiving a Family Tree).

Unlocking a Family Tree
When GRAMPS opens a tree, it locks the tree, preventing you or any-
one else opening it at the same time. A second copy of GRAMPS will
be able to open another family tree, but the tree already open will ap-
pear with the lock icon, indicating you cannot open it. Closing the tree
in the first copy of GRAMPS will make it available to be opened in
the second copy.

If you could open the same Family Tree in two GRAMPS at once,
it is likely your data would be damaged.
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In the unlikely event of a crash of GRAMPS, the family tree will
be left in a locked state. To unlock the tree, select the locked family
tree, and click the Unlock button that will be available. Only do this if
you are sure no other copy of GRAMPS is using this family tree.

Repairing a damaged Family Tree

Fig. 3.4 Repairing a Family Tree

Should your Family Tree become damaged or corrupted in some
way, GRAMPS’ Family Tree Manager will display a red Error icon in
the Status column.

To tell GRAMPS to attempt to repair the damage, select the Tree
and then click the Repair button.

This will attempt to rebuild your tree from the backup files that are
automatically created on exit.

Saving changes to your Family Tree
GRAMPS saves your changes as soon as you apply them. This means,
for example, that any time you click OK when using GRAMPS, your
changes are immediately recorded and saved. There is no separate
"save" command.

You can undo changes you’ve made by selecting Edit ->Undo . If
you select this command repeatedly, your most recent changes will be
undone one at a time. To roll back multiple commands at a time, you
can using the Undo History dialog available from the Edit menu.

If you want to return your Family Tree to the way it was when you
opened it, select Family Trees ->Abandon changes and quit . (This
is just like quitting without saving in other programs.)

If you would like to save a copy of your Family Tree under a dif-
ferent name, you will need to export it and then import it into a new
Family Tree. The GRAMPS XML database format is recommended
for this purpose.

Importing data
Importing allows you to bring data from other genealogy programs in-
to a GRAMPS database. Currently, GRAMPS can import data from
the following formats:
• GRAMPS XML (.gramps file extension)
• GRAMPS package (.gpkg file extension)
• GRAMPS CSV Spreadsheet - comma separated values (.csv file

extension)
• GRAMPS V2.x database (.grdb file extension)
• GEDCOM (.ged file extension)
• GeneWeb (.gw file extension)
• Pro-Gen (.def file extension)
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Importing vs. opening
Please recognize that importing a data-
base is different from opening a database.
When you import, you are actually bring-
ing data from one database into a
GRAMPS database. When you open a
file, you are editing your original file.

To import data, select Family Trees ->Import . The Import data-
base dialog will open, asking you to specify the file you wish to im-
port. Note that you can only import data into an existing database so
if you are transferring all your data from another program or from an
older version of GRAMPS, then first create a new empty database and
then import the data into it.

Data loss with some formats
It is important to note that the importing
process is not perfect for GEDCOM and
GeneWeb databases. There is a chance
that some of the data in these databases
will not be imported into GRAMPS.

Order "up side down" Events
generated under other programs
Gramps provides an help for ordering
events according to your preferences.
See Sort Events tool.

The GRAMPS XML, GRAMPS package and GRAMPS V2.x data-
base are all native GRAMPS formats. There is no risk of information
loss when importing from or exporting to these formats.

• GRAMPS XML (.gramps): The GRAMPS XML file is the
standard GRAMPS data-exchange and backups format, and was
also the default working-database format for older (pre 2.x)
versions of GRAMPS. Unlike the grdb format, it is architecture
independent and human-readable. The database may also have
references to non-local (external) media objects, therefore it is not
guaranteed to be completely portable (for full portability
including media objects the GRAMPS package (.gpkg) should be
used). The GRAMPS XML database is created by exporting ( ) to
that format.

• GRAMPS package (.gpkg): The GRAMPS package is a
compressed archive containing the GRAMPS XML file and all
media objects (images, sound files, etc.) to which the database
refers. Because it contains all the media objects, this format is
completely portable. The GRAMPS package is created by
exporting ( ) data in that format.

• GRAMPS V2.x database (.grdb): Prior to Version 3.3, this native
GRAMPS database format was a specific form of Berkeley
database (BSDDB) with a special structure of data tables. This
format was binary and architecture-dependent. It was very quick
and efficient, but not generally portable across computers with
different binary architecture (e.g. i386 vs. alpha).

If you import information from another GRAMPS database or
GRAMPS XML database, you will see the progress of the operation in
the progress bar of GRAMPS’ main window. When the import finish-
es, a feedback window shows the number of imported objects. If the
imported data originates from the very family tree in which you im-
port the data, the import feedback gives suggestions about what could
be merged; the merge is not done automatically for you. If you want to
merge basic genealogy data automatically, consider CSV Spreadsheet
Export/Import.
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The GRAMPS CSV Spreadsheet format allows importing and ex-
porting of a subset of your GRAMPS data in a simple spreadsheet for-
mat. See CSV Import and Export for more information.

Exporting data

Fig. 3.5 Export assistant: format selection

Exporting allows you to share any portion of your GRAMPS database
with other researchers as well as to enable you to transfer your data to
another computer. Currently, GRAMPS can export data to the follow-
ing formats: GRAMPS XML, GEDCOM, GRAMPS package, Web
Family Tree, GeneWeb, and GRAMPS CSV Spreadsheet formats.

Export is saving a copy

When you export, you are saving a copy
of the currently opened database. Export-
ing creates another file with a copy of
your data. Note that the database that re-
mains opened in your GRAMPS window
is NOT the file saved by your export. Ad-
ditional editing of the currently opened
database will not alter the copy produced
by the export.

To export data, choose Family Trees ->Export . This will bring up
the Export assistant. Its pages will guide you through the format se-
lection (see Fig.3.4 ), file selection, and format specific export options.
After a final confirmation page, the export will be performed accord-
ing to the choices you have made. At any time, you can click the Back
button and revise any selection, and then go forward to redo the ex-
port.

Filters and privacy
GRAMPS allows you to export a database into common file formats.
It provides options that allow you to fine tune your export.
• Filters on People and Notes: Filters allow you to export a limited

amount of data, based on the criteria you select.
• Do not include records marked private: Check this box to prevent

private records from being included in the exported file.
• Restrict data on living people: Check this box to limit the

information exported for living people. This means that all
information concerning their birth, death, addresses, significant
events, etc., will be omitted in the exported file. If you choose
this option, you will be given additional options to limit further
the data on living people. For example, you can choose to
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substitute the word for the first name (see your settings); you can
exclude notes; and you can exclude sources for living people.

• Do not include not related records: Check this box to prevent not
related records from being included in the exported file.

Sometimes, it is not always obvious from the data if someone is actu-
ally alive. GRAMPS uses an advanced algorithm to try to determine if
a person could still be alive. Remember, GRAMPS is making its best
guess, and it may not always be able to guess correctly all the time.
Please double check your data.

Export into GRAMPS formats

Privacy Filters
It is important to verify your privacy op-
tions on Exporter. Do not enable filters
or privacy options for GRAMPS XML
backups.

• GRAMPS XML database export (.gramps): This format is the
standard format for data-exchange and backups (see the related
.gpkg format below for full portability including media objects).
Exporting into GRAMPS XML format will produce a portable
database. As XML is a text-based human-readable format, you
may also use it to take a look at your data. This format is
compatible with the previous versions of GRAMPS.

• GRAMPS package export (.gpkg): Exporting to the GRAMPS
package format will create a compressed file that contains the
GRAMPS XML database and copies of all associated media files.
This is useful if you want to move your database to another
computer or to share it with someone.

• Export to CD: Exporting to CD will prepare your database and
copies of all media object files for recording onto a CD. To
actually burn the CD, you will need to go to the GNOME

location, which can be accessed by navigating through Nautilus:
After exporting to CD, select Go ->CD Creator in the Nautilus
menu. Your database directory will show up. To burn it to the
CD, click the CD icon on the Nautilus toolbar, or select File -
>Write to CD in the Nautilus menu.

If a media file is not found during export, you will see the same Miss-
ing Media dialog you encounter with GEDCOM export.

Exporting into the GEDCOM format

Fig. 3.6 Export assistant: GEDCOM options

GRAMPS allows you to export a database into the common
GEDCOM format. It provides options that allow you to fine tune your
export (see Fig.3.5.gedcom-export-fig ).
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• Filters on People and Notes: Filters allow you to export a limited
amount of data, based on the criteria you select.

• Do not include records marked private: Check this box to prevent
private records from being included in the exported file.

• Restrict data on living people: Check this box to limit the
information exported for living people. This means that all
information concerning their birth, death, addresses, significant
events, etc., will be omitted in the exported file. If you choose
this option, you will be given additional options to limit further
the data on living people. For example, you can choose to
substitute the word for the first name (see your settings); you can
exclude notes; and you can exclude sources for living people.

• Do not include not related records: Check this box to prevent not
related records from being included in the exported file.

Export into other formats
• Web Family Tree: Exporting to Web Family Tree will create a

text file that can be used by the Web Family Tree program.
Export options include filter selection and the ability to limit data
on living people to that of their family ties.

• GeneWeb: Exporting to GeneWeb will save a copy of your data
into a popular web genealogy format. To find out more about
GeneWeb and its format, visit http://cristal.inria.fr/~ddr/
GeneWeb/en/.

• vCalendar and vCard: Exporting to vCalendar or vCard will save
information in a format used in many calendaring and
addressbook applications, sometimes called PIM for Personal
Information Manager.

• GRAMPS CSV Spreadsheet format: Allows exporting (and
importing) a subset of your GRAMPS data in a simple
spreadsheet format. See CSV Import and Export for more
information. Also, see Export Display .

Moving 2.2 databases to Gramps 3
There are two ways of moving your Gramps data from version 2.2 to
version 3; either directly importing your version 2.2 grdb file or by ex-
porting to XML format first. Because of complexity in the way that
version 2.2 stores data, exporting to XML is usually the most conve-
nient and problem free way of moving your data to version 3.
• Import 2.2 grdb file: In a Gramps 2.2 database, your data is stored

in a grdb file along with one or more log files that are kept in
directories found in the .gramps/env directory. To import your 2.2
data directly into Gramps 3, create a new database and select the
option to import a Gramps 2.2 database. You need to make sure
that you are running Gramps 3 from the same user you used to
run Gramps 2.2 so that it has access to the same .gramps/env
directory containing the log files that supplement your database.
If you are running Gramps 3 from a different user or on another
machine you need to make provisions to make the same .gramps/
env directory and log files available. If you get an error saying
"/tmp/tmpDkI5pO could not be opened" or something similar
when attempt to import your database then it means that Gramps
3 cannot see all of the files that constitute your database.

• Gramps XML: With this approach firstly start up Gramps 2.2 and
export your database to the Gramps XML format. The XML file
is actually compressed and contained in a .gramps file. This file is
portable, has no other dependent files and can be moved to
wherever you have Gramps 3 installed. Next, start Gramps 3 and
create an empty database using the Family Tree Manager and
import the .gramps file.

Previous Index Next
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Gramps 3.3 Wiki Manual - Entering and editing data: brief

This section is designed to give you the basic knowledge necessary to
start putting your genealogical information into GRAMPS. It will ex-
plain how to enter people into the database and how to specify their
family relationships. (A more detailed explanation will follow in the
next chapter: Gramps 3.3 Wiki Manual - Entering and Editing Data:
Detailed.)

Special copyright notice: All edits to this page need to be
under two different copyright licenses:
• GNU Free Documentation License 1.2 - see wiki

copyright
• GPL - see manual copyright

These licenses allow the Gramps project to maximally use
this wiki manual as free content in future Gramps versions.
If you do not agree with this dual license, then do not edit
this page. You may only link to other pages within the wi-
ki which fall only under the GFDL license via external
links (using the syntax: [http://www.gramps-project.org/
...]), not via internal links.
Also, only use the known conventions

Previous Index Next

Introduction
First, let’s identify the types of information you can enter into your
GRAMPS database. These include:
• Personal information about an individual (names, addresses, birth

and death dates, etc.)
• Information about an individual’s relationships (marriages,

divorces, civil unions, etc.)
• Information about an individual’s parents and children
• Sources that document your research

Keybindings
In addition to interacting with GRAMPS
through menu items and buttons, you can
use its extensive set of "keybindings." For
more information, see append-keybind .

Now let’s take a quick look at how you can enter and edit these various
types of information.

To add or edit a person
There are multiple ways to add a person to the database. We will cover
some of them as we proceed. The simplest way to enter a person to
add them from the People View. While you are in the People View
(side-nofilt-fig), click the Add button on the toolbar. Enter any data
you know about this person into the Edit Person dialog (see edit-pers-
fig for details).
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To edit information about a person already present in the database,
select the person from the People View and click the Edit button on
the toolbar.

Alternate ways of adding or editing
a person from the People View
You can also use Add... and Edit... menu
items available under Edit. Or you can
right-click on the person and select
Add... or Edit... from the context menu
that pops up.

People can also be added to the database in the Relationships View,
Edit Family dialog, and other places where it makes sense.

To specify a relationship
There are two primary ways to specify relationships between people -
using the Relationships View and using the Edit Family dialog from
the Family List View. The Family List is usually used to build all the
relationships within a single family at a time. The Relationships View
is usually used to build multiple relationships to a single person.

To specify a new relationship to the Active Person, switch to the
Relationships View (family-fig) and you’ll see this individual indi-
cated as the "Active Person". Next to the Family label is a Add button
(typically represented by a + sign). Clicking the Add button will dis-
play the Edit Family dialog with the Active Person set as either the
father or the mother.

Fig. 4.1 Editing a family

Now a question: Does the person who will form the relationship with
the Active Person already exist in the database? If yes, click the Select
button to the other person. You’ll then be able to browse through the
list of people in the database to select the one you want. If not, click
the Add button. This will allow you to add a new person to the data-
base and to specify the relationship this person has to the Active Per-
son.

Filtering
By default, GRAMPS filters the dis-
played list to show only those people who
could theoretically have a relationship
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with the Active Person. That is,
GRAMPS only shows those people
whose birth dates and death dates fit with-
in the lifetime of the Active Person. If
you wish, you can add a person to the list
by clicking the + button. To completely
override the filter and display all people
from the database, check the Show all
box.

To search a person on dialog selec-
tor
Remember that you can get an entry on
the list by typing the first letter on your
keyboard. (see Finding records)

Fig. 4.2 Selecting a person

To edit an existing relationship from the Relationships View,
click on the Edit button next to corresponding Family entry. If there
is more than one relationship in the list, you can select the spouse or
partner you want by clicking the corresponding Edit button next to the
relationship.

To specify a new relationship in the Family List View, click on
the Add button on the toolbar, and an empty Edit Family dialog will
open. At this point, you can add people to the family.
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To specify parents

Fig. 4.3 Select family

You can specify Active Person’s parents in the Relationship View
(family-fig). A little care is required to prevent the creation of dupli-
cate families. If you wish to add the Active Person to an already exist-
ing family, you should click the Select button. If the family including
the parents does not already exist, you should click the Add button.

If you click on the Select button, you are presented with the Select
Family dialog. This will allow you to select the existing family, and
then the Active Person will be added as a child to the family.

If you click on the Add button, a new Edit Family dialog is presented
with the Active Person listed a child of the new family. You can add

the parents to the family by either adding new people as the parents or
selecting existing people as the parents.

Warning
If you create a new family and select
parents that are already in an existing
family, GRAMPS will issue a warning
message. If you proceed by saving the
new family, you will have a duplicate
family.

Fig. 4.4 Duplicate family

You can also specify the parents of a person in the Family List
View. If the family already exists, click on the Edit button on the tool
bar and add the person as a child when the Edit Family dialog is dis-
played. If the family does not already exist, click the Add button to
create a new family, and add the appropriate parents and children.
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To specify children

Fig. 4.5 Child reference editor

Adding children to a relationship is done through a similar procedure.
From the Relationships View or the Family List View, select the ex-
isting family or create a new family. Children can be added by select-
ing the Add button or Select button to the right of the child list.

Clicking the Add button will display the Edit Person dialog, al-
lowing you to enter a new person. Clicking on the Select button, will
allow you to select an existing person from a list. By default, the child
is added with a the relationship type of birth to both parents.

If you wish to change the parent/child relationship from the default
setting of birth, select the child and click on the Edit button . This
will display the Edit Child Reference dialog.

If you wish to change the order of the children in the phratry, use
the arrows or the drag and drop function on Family Editor .

Adding photos and other media objects
You can add photos and other media objects to individual people,
events, sources, and places. You can also add images that might not be
limited to a single person or event (for example, group family photos).

If you want to add an image to a single person, switch to the Peo-
ple View (mainwin-fig), select a person, and then click the Edit icon
on the toolbar. This will bring up the Edit Person dialog (edit-pers-
fig). Next, select the Gallery tab, and click the + button to call up
the Select a media object dialog. Type a filename or browse to find
the image file you want and then provide a title for that image. Keep
adding images until you are done.

To add images related to a relationship (for example, a marriage),
switch to the Family View (family-fig) and double-click on the
Spouse box. This calls up the Marriage/Relationship editor dialog.
Select the Gallery tab and click the + button to add an image.

To add images related to a source or a place, first switch to
the Source View (sources-fig) or Place View (places-fig). Select the
source or place you want and then either double-click on it or click the
Edit icon on the toolbar. Select the Gallery tab and click the + button
to add an image.

Finally, to add images that you want to include in the database, but
hare are not limited to any particular person, relationship, source or
place, switch to the Media View (media-fig). Then click the Add icon
on the toolbar to add an image. If you have already added any images
to any individual galleries, you will also find them listed in the Media
View.
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Alternate way of adding images to
galleries
An image can always be added to any
gallery by using drag-and-drop. Items can
be dragged from the Media View, any
gallery, the desktop, the file manager or a
web browser and dropped on the target
gallery, adding the image to the gallery.

In any gallery, you can also use the Edit to edit image information and
the - button and to remove the image reference from that gallery.

Removing an image from a gallery
Removing a media object from a gallery
does not remove the image from the data-
base. To completely remove the image
from the database, delete it from Media
View by first selecting it and then click-
ing the Remove icon on the toolbar.

To edit events, sources, places, and reposito-
ries
To add an event, a source, a place, or a repository to the database,
switch to the appropriate Events View ( events-fig), Sources View
(sources-fig), Places View (places-fig), or Repositories View
(repository-fig). Then click the Add icon on the toolbar to add the
corresponding object. Enter the information into the Event Editor (
Source Editor , Place Editor , or Repository Editor ) dialog.

To edit information about events, sources, places, and repositories
already present in the database, switch to the appropriate view, select

an entry you would like to view/modify, and then click the Edit icon
on the toolbar. Alternatively, you may double-click on the entry to edit
it.

Previous Index Next
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Gramps 3.3 Wiki Manual - Entering and editing data: detailed

The previous section offered you a quick overview of how to enter and
edit data in GRAMPS. This section continues that discussion in much
greater detail.

Special copyright notice: All edits to this page need to be
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Introduction
As we have seen above, GRAMPS offers you a series of Views. Each
of these Views gives you opportunities to enter and edit informa-
tion. In fact, you can often get to the same information from different
Views.

In GRAMPS, information is entered and edited through what we
call dialogs. Since we use that term frequently, we should define what
we mean by it:

A dialog is a pop-up window that provides one or more forms
for entering and editing data that fits a certain category. Examples in
GRAMPS include the Edit Person dialog and the Family Editor dia-
log, among many others.

A dialog often includes a series of "notebook tabs" that group the
information into subcategories. For example, the Edit Person dialog
has notebook tabs for subcategories such as Events, Attributes, Ad-
dresses, and Notes, among others.

Add, Remove, and Edit buttons
In most cases, GRAMPS uses a + to cor-
respond to Add+ , a - correspond to Re-
move , and an icon of a pen on a sheet of
paper to denote Edit . We will continue
referring to the latter as the Edit+ button,
while using + and - to denote the two for-
mer buttons.
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Details
1. Gramps 3.3 Wiki Manual - Entering and Editing Data: Detailed -

part 1: Learn how to add persons, dates, families and
relationships to GRAMPS

2. Gramps 3.3 Wiki Manual - Entering and Editing Data: Detailed -
part 2: Learn about the other core objects in GRAMPS: events,
sources, places, repositories and notes

3. Gramps 3.3 Wiki Manual - Entering and Editing Data: Detailed -
part 3: Learn how attributes and addresses work, as well as how
you can merge data.
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Gramps 3.3 Wiki Manual - Navigation

As long as any database is open, GRAMPS is focused on a single per-
son usually referred to as an Active Person. This allows you to view
or modify the data concerning this person, his or her immediate fam-
ily, etc. Navigating in the database (i.e. moving from person to per-
son) is in fact nothing else but changing the Active Person. This sec-
tion describes many alternative ways to navigate through the database
using both the complex and the convenient interfaces GRAMPS pro-
vides. All these ways eventually accomplish the same thing, but some
are more convenient than others, depending what you are doing in
GRAMPS at the moment.

Special copyright notice: All edits to this page need to be
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Using the People View
The most intuitive way to select an Active Person is to use the People
Category. When in the People View, just select the name of the desired
person from the list by clicking that list entry. The person you have
selected becomes active. The statusbar updates to reflect the change of
the active person.

Using the Family View
When in the Relationships, you can easily navigate between the mem-
bers of the displayed family as follows:

To make the currently selected spouse the Active Person, click the
double-arrow button to the right of the Active Person box. Alterna-
tively, right-click into the spouse box and select Make the selected
spouse an Active Person item from the context menu.

To make the currently selected parents the active family (thereby
making father the Active Person and mother the selected spouse), click
the right-arrow button to the right of the active person’s parents box.
Alternatively, right-click into the active person’s parents box and se-
lect Make the selected parents the active family item from the con-
text menu.

To make the currently selected spouse’s parents the active family
(thereby making father the Active Person and mother the selected
spouse), click the right-arrow button to the right of the spouse’s par-
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ents box. Alternatively, right-click into the spouse’s parents box and
select Make the selected parents the active family item from the
context menu.

To make the currently selected child the Active Person, click the
left-arrow button to the right of the children box. Alternatively, right-
click into the children box and select Make the selected child an Ac-
tive Person item from the context menu.

In addition to this, GRAMPS provides an extensive set of key-
board navigation options. The detailed reference to the key bindings is
found in the append-keybind.

Using the Ancestry Views
The Ancestry Category also allow you to move along the family tree.
The benefit of this method is that you can see more than one genera-
tion of the family tree. Also, you can jump directly from a great-grand-
son to a great-grandfather without going through the intermediate gen-
erations.

Note that after changing the Active Person in the Ancestry Views,
the display is re-adjusted to show up to five generations, starting from
the newly selected Active Person. When in the Ancestry Views, you
can easily navigate between the members of the displayed family tree
as follows:

To make any displayed person the Active Person, right-click the
corresponding box and choose the first entry in the context menu.

To make a child of the currently Active Person (if any) the Active
Person, click the left arrow button to the left of the corresponding box.
If there is more than one child, the button expands to the menu listing
the children to choose from.

To move the whole family tree one generation back, click on the
corresponding right arrow button on the right-hand side of the display
area. Clicking the upper button will move the tree along the paternal

line. Clicking the lower button will move the tree along the maternal
line.

Clicking either of these buttons is completely equivalent to
double-clicking the lines connecting to the left of the corresponding
boxes for father and mother.

You can also quickly access any of the spouses, siblings, children,
or parents of any displayed person. To do this, move the mouse over
the desired person’s box and right-click to invoke a context menu. The
appropriate menu items will contain submenus listing all spouses, sib-
lings, children, and parents of the corresponding person.

Advantages of using right-click
menus
Direct access to spouse and siblings.
Complete lists of all member of all cate-
gories, not only the preferred members.

Setting the Home Person
One and only one person in the database can be selected as the Home
person. Once the Home person is selected, moving to that person be-
comes a matter of a single click, regardless of which view you are us-
ing at the moment.

To set the Home person, first navigate to that person using any
method you like. Then choose Edit ->Set Home person . Once this is
done, you can move to the Home person from anywhere in the data-
base by simply clicking the Home icon on the toolbar. You can al-
so choose Go ->Home from the menu or select Home item from any
context menu available on the right click.
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Using history-based tools
GRAMPS also features a powerful set of history-based navigation
tools. These tools are similar to those commonly used in web
browsers. They include Back and Forward items available from the
Go menu, context menus (available in People, Family, and Pedigree
views), and the toolbar buttons. They also include the list of the recent
selections available under the Go menu that allows you to jump di-
rectly to any of the recent selections. Finally, right-clicking on the
Back and Forward toolbar buttons invokes the popup menu with cor-
responding portion of the history. Select any item from the menu to
jump directly to it.

Bookmarks

Fig. 6.1 Organize bookmarks

Similar to setting the Home person, you can bookmark other people
from the database to simplify further navigation. To bookmark a per-
son, first navigate to that person, then choose Bookmarks ->Add
bookmark . To move to that person from anywhere in the database,
choose Bookmarks ->Go to bookmark ->Person’s name .

You can manage your bookmarks by choosing Bookmarks ->Or-
ganize bookmarks... . This opens the following Organize Book-
marks dialog with the list of bookmarks and the controls to modify
this list.

Use the Up en Down button to change the list sequence. Use the
Remove button to remove a Bookmark. The Help will bring you to
this page, and you close the Organize Bookmarks window with the
Close button.

The Bookmarked People can be selected through the People View,
as explained above, but also through the Relationships View, Families
View, and the Pedigree View.

On a similar basis you can also Bookmark: Events, Sources, Places,
Media, Repositories , and Notes
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Finding records

Fig. 6.2 Type-ahead find

To find a record in a database, first switch to the appropriate View
that provides the list of the desired records: People, Sources, Places, or
Media. Then start typing the name of a person or the title of a Source,
Place, or Media object that you are looking for, respectively. You may
also press <Ctrl> + F to turn on the search mode, but simply starting
to type is also enough.

As you type, the first record in the list that is compatible with your
input will be selected.

Finding People
For more complex people searches you
may want to use filters.

Enable filter controls by choosing
View ->Filter , select the desired filter,
and click Apply . For details, see Fil-
ters.

Using the Clipboard

Fig. 6.3 Clipboard

This tool provides a temporary note pad to store database records for
easy reuse. In short, this is a sort of the copy-and-paste functional-
ity extended from textual objects to other types of records used in
GRAMPS.
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Clipboard makes extensive use of
drag and drop technique
To invoke Clipboard, either choose
Edit->Clipboard or click the Clip-
board button on the toolbar.

Clipboard supports addresses, attributes (both personal and family),
events (both personal and family), names, media objects references,
source references, URLs, and of course textual information of notes
and comments. To store any type of these records, simply drag the ex-
isting record on to the Clipboard Pad from the corresponding editor
dialog. To reuse the record, drag it from the Clipboard on to the corre-
sponding place in the editor, e.g. Address tab, Attribute tab, etc.

Tip
Some objects are showing the link icon
on the left. This indicates that dragging
such selection will produce a reference
to an existing object, not copy the object
itself. For example, the media object file
will not be duplicated. Instead, the refer-
ence will be made to an existing media
object, which will result in the local
gallery entry.

Tip
Clipboard storage is persistent within a
single GRAMPS session. Closing the
window will not lose the stored records.
However, exiting GRAMPS will.

The accelerator key is now <CTRL+B> . For an application like
GRAMPS the Clipboard is very important. Just one example: You
find a birth certificate of a person. In this certificate also the witnesses
are mentioned. And the birth certificate also determines a source
where the information was stored. The best way is to open the clip-
board and drag the source you want to work with there. Then use drag
and drop to use it in new items you use. Now you can finalize the in-
formation on the person editor screen. Drag that info also to the Clip-
board. Now you add two new persons for the witnesses (assuming you
do not have them already in your database). Simply drag and drop the
birth info to the witness event screen. You are then presented with the
screen where you can change the role of the witness to witness for this
birth event. You do the same with the other witness.

This saves you a lot of typing and possible errors.

Windows Manager

Fig. 6.4 Windows manager

Windows -> Menu provides a quick access to opened windows.

Previous Index Next
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Gramps 3.3 Wiki Manual - Plugin Manager
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The Plugin Manager menu item is under the Help menu. Many of the
features of the Plugin Manager are intended for developers, and the
dialogues described below are those seen by developers. The features
for normal users are noted below where they are different.

Gramps detects whether it is being run in User mode or Developer
mode by the ’optimise’ flag:

python -O gramps.py

See Debugging GRAMPS.

Gramps consists of a core plus many plugins. When Gramps starts,
the core is loaded and only a limited number of plugins are loaded.
This decreases the startup time and memory requirements of Gramps.
Subsequently, many plugins are automatically loaded by Gramps as
they are needed, so that many users will not need to be aware of the
existence of plugins, or their delayed loading.

The Plugin Manager allows you to control how Gramps manages
plugins.

Plugin types
There are two main categories of plugins in Gramps: "user plugins"
and "system plugins". User plugins are those that you use and control
to provide different functionality for you. The system plugins are used
by Gramps.

The following types of User Plugins are present in Gramps:
1. doc creators: Backends for which Gramps can write reports (pdf,

odf, ascii text, ...)
2. exporters: export formats you can export your data too via
3. gramplets: small programs you can embed in the GrampletView,

or detach and use as a normal window
4. gramps views: the views visible in the main window of Gramps
5. importers: import formats from which Gramps can import data
6. map service: targets that can be used on the place view to go to an

internet map service (Go toolbar button)
7. quickreport: small reports that are available in the context menu

on the listviews, or via the Quickreport gramplet
8. reports: Textual or graphical reports Gramps can produce
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9. tools: Tools you can start via the menu
The following types of System Plugins are present in Gramps:
1. plugin libs: libraries that are present giving extra functionality.
2. relationships: relationship calculators for different languages
There are many plugins that come with Gramps. However, anyone can
also write a plugin and share it. These third-party plugins are called
"addons". We highly encourage users and developers to share their
creations with other Gramps users.

Registration and loading
Plugins are either held locally on the computer and are known about
by Gramps, when they are said to be Registered, or they are held on
a remote computer and Gramps only knows their name, type and de-
scription, when they are said to be Addons.

When it starts, gramps automatically reads information about the
local plugins, so that they become registered. The Plugin Manager can
be used to download remote Addons so that they too become regis-
tered.

Registered (i.e. local) plugins are loaded by Gramps in the follow-
ing situations:
1. they are automatically loaded at startup. Some plugin types are

loaded at startup (e.g., non hidden views), some plugins can have
a flag that forces load on startup,

2. they are automatically loaded by virtue of the user clicking on a
view or requesting a report,

3. they are loaded by the user explicitly requesting load in the plugin
manager,

4. remote plugins are loaded at the same time as they are registered
by using Install Addons described below.

Hide/Unhide
The plugin Manager can be used to hide or unhide plugins. Some
menus will not display hidden addons, so that the addon cannot be se-
lected. For example, if a Gramplet is hidden, then it will not appear in
the "Add a gramplet" context menu which appear when right clicking
the background of the Gramplets main tab. However, hiding some ad-
dons (such as Relationships or Gramps Views) has no effect and may
not even be allowed.

Actions
There are three tabs of the Plugin Manager: Registered Plugins, Load-
ed Plugins, and Install Addons.

Registered Plugins
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Here you see a list of all plugins that Gramps has found. These are
the plugins which are part of Gramps, as well as the plugins found in
the gramps32/plugins directory within the GRAMPS User Directory.
The type of plugin is shown in the first column.

A plugin can be made hidden or unhidden. This is only useful for
the User Plugins.

Loaded Plugins

Here you see a list of all plugins that have been attempted to be
loaded. Normally, all views (such as the Relationship View) will be
loaded, and all gramplets/reports/tools you have used will be loaded
automatically.

If there was an error during the loading of a plugin, then the staus
will be shown in this tab. Double clicking a row showing a failure
opens a dialog showing the error in detail. You can use this to contact
the plugin author or the gramps bug list.

Install Addons

Here you will initially see an empty list. By clicking the "Refresh
Addon List" button, Gramps will fetch the listed third-party plugins
(known as Addons) listed at 3.3 Addons. You may wish to refresh this
list every once in a while to see the latest Addons.

Also, you can enter an Addon’s URL or path to a filename in the
"Path to addon" to load the Addon.

An addon is a packaged set of files made to run in this version of
Gramps. The addon package may end in "addon.tgz" or ".zip". You
cannot install a .py file directly, but will need to install the .gpr.py and
.py files by having access them in a package. For details on creating
an Addon, see Addons Development.
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After refreshing the addon list you may also click on a specific Ad-
don listed. This will place the URL of the add in the "Path to addon".
Then you can select "Install Addon" to download and install the se-
lected Addon.

You may also select "Install All Addons". This will go through the
list and download (or update) all of the listed Addons.

Later if you decide that you do not like an Addon, you can mark it
"hidden" and it will no longer show.

Previous Index Next
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This page details the functionality of the Gramplets. If you would
like to read more technical details about writing your own Gramplet,
please see Gramplets. For more Gramplets that you can extend your
Gramps functionality with, see Third-party Plugins.

Gramplets

Fig. 7.1 Gramplets View

A GRAMPS Gramplet is a view of data that either changes dy-
namically during the running of GRAMPS, or provides interactivity to
your genealogical data. What is the difference between gramplets, re-
ports, quick views, and tools?
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• Reports provide a static output format of your data, typically for
presentation

• Quick View provides a typically short, interactive listing derived
from your data

• Tools provide a method of processing your data
• Gramplets provide a dynamic view and interface to your data

Gramplets are the widgets that are part of GRAMPS and can be seen
in the Gramplet View and Sidebars, Bottombars. The widgets provide
all kind of functionality that can be useful for the researcher.

When you first start the View you will see the Welcome Message
Gramplet and the Top Surnames Gramplet.

Fig. 7.2 Detached Gramplets View

You can drag the Properties button (top left) of each gramplet
to move it around the screen. Clicking the Properties will detach the
gramplet from Gramplet View and place it in its own window. The
window will stay open regardless of page (relationship, ancestry, etc).
Closing the detached view will put it back onto the Gramplets view. If
you quit Gramps with a open gramplet, when you start gramps again,
it will open automatically.

When one or more Gramplets are undocked from the Gramplet
View, you can change to a different view (such as the People or
Ancestry Views). In this way, you can use these gramplets to supple-
ment a particular view with additional details and functionality pro-
vided by the gramplet.

You can add new gramplets by right clicking on an open space on
Gramplets. You can also change the number of columns by right-
clicking an open area on the Gramplets page.

These are 18 default gramplets:
1. Age on Date Gramplet - see the people alive and their ages on a

particular date
2. Age Stats Gramplet - see age span graphs
3. Attributes Gramplets - see active person’s attributes
4. Calendar Gramplet - see people’s events on a particular date, or in

a month in the past
5. Descendants Gramplet - see the active person’s descendants
6. Fan Chart Gramplet - see the active person’s pedigree, in a

circular fan chart
7. Given Name Cloud Gramplet - most popular given names
8. Pedigree Gramplet - see a complete pedigree in compressed text
9. Quick View - run a Quick View on the current person

10. Records Gramplet - see world’s records of your data
11. Relatives Gramplet - see the relatives of the active person
12. Session Log Gramplet - keep track of what you have done, and

what records you have visted
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13. Statistics Gramplet - see stats on the database
14. Surname Cloud Gramplet - most popular surnames as a "text

cloud"
15. TODO Gramplet - a notepad to keep tabs on your research
16. Top Surnames Gramplet - top 10 most popular surnames
17. Welcome Gramplet - a GRAMPS welcome message
18. What’s Next Gramplet - what needs to be done next

Additional Gramplets
Starting with Gramps version 3.3 a new
system was implemented to have even
more Gramplets available. This system is
controlled by the Plugin Manager. The
Plugin Manager can get additional Ad-
dons for you. Check the list of the avail-
able reports here.

Here you can see the other gramplets available on this moment:
• Data Entry Gramplet - edit active person’s name, birth date and

place, death date and place, and add people
• Note Gramplet - see and edit active person’s primary Person Note
• Headline News Gramplet - current, breaking news from

GRAMPS
• FAQ Gramplet - frequently asked questions
• Python Gramplet - a Python shell

If a link in a Gramplet is to a specific person, then clicking the link
will change the Active Person. Double-clicking such any link to a spe-
cific GRAMPS item (such as person or family) will bring up the Edi-
tor for that item. To edit a linked person without changing the Active
Person, right-click on the person link. Depending on the type of entry,
double-clicking any row in a Quick View table will either select more
specific data (drill down) or bring up the editor.

This section will describe each gramplet and its basic functionali-
ty.

Changing settings
You can change the settings of the Gram-
plets by editing your ~/.gramps/gram-
plets.ini file. But you can only do that
when GRAMPS is not running. Just bring
up the gramplets.ini file in a text editor
and make the desired changes. You can
change the title of the Gramplet by chang-
ing the section name (surrounded by
square brackets). These options will be
able to be changed via the Gramplet View
in the next version of GRAMPS. If you
have an idea for additional Gramplets,
please let us know!
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Age on Date Gramplet

Fig. 7.3 Age On Date Gramplet
Fig. 7.3a Age On Date Quick Report

This Gramplet gives you the possibility of entering a date in an entry
field. If you click Run the Gramplet will compute the ages for every-
one in your Family Tree on that Date. The date must be entered in a
format that GRAMPS accepts.

You can then sort by the age column, and double-click the row to
view or edit.
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Age Stats Gramplet

Fig. 7.4 Age Stats Gramplet

Fig.7.5 Age Stats Gramplet showing options

The Age Stats gramplet shows graphs of the breakdown of particular
age spans. Clicking on a row will bring up the associated people.
You can change the gramplet’s options by detaching, and selection the
options drop-down area, and pressing Save .
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Calendar Gramplet

Fig. 7.8 Calendar

The Calendar gramplet shows a monthly calendar. Double-click a day
to run the On This Day Quick View.
With the < and > buttons top left corner (month) you can change to the
previous and next month.

With the < and > buttons top right corner (year) you can change to
the previous and next year.

The Quick View window shows you the Events of the selected
day: Events on this exact date and Other events on this Month/day in
history as well as Other events in that year.

The information is presented in a table showing:
• Date
• Type
• Place

• Reference
You can also drag a date to the date field of the Age on Date Gramplet
to enter that date.

Given Name Cloud Gramplet

Fig. 7.11 Given Name Cloud Gramplet

Like the Surname Cloud Gramplet, the Given Name Cloud gramplet
shows the top most popular given names in your family tree. The size
of the name indicates how popular it is. Mouse over the name to see
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the exact count, and the percent of people in the family tree that have
that name.

The gramplet splits up given names into words (broken up by
spaces). For example "Sarah Elizabeth" would appear under both
"Sarah" and "Elizabeth".

Double-click on the given name to bring up a Quick View of all of
the matching people.

Quick View Gramplet

Fig. 7.13 Quick View Gramplet

The Quick View gramplet allows you to run a Quick View, but it
updates as you move from person to person. (Currently, only People
Quick Views can be run).

You can run any of the Quick Views for a person.

You can change the options by clicking the Option button (top, left
hand button of the Gramplet) which will detach the gramplet and bring
it up an a window. Select Options on the top row, and a list of options
will appear. Press Save to apply the changes to the Quick View. You
may then close the window to reattach the gramplet.

Currently, the Quick View Gramplet doesn’t remember which
Quick View between GRAMPS sessions, so you’ll have to reselect it
when you restart GRAMPS. This will be fixed in an upcoming version
of GRAMPS.
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Records Gramplet

Fig 7.14 Records Gramplet

The Records Gramplet shows a number of interesting records (mostly
age related) in your database. The list shows the top three for each el-
ement.
• Youngest living person
• Oldest living person
• Person died at youngest age
• Person died at oldest age

• Person married at youngest age
• Person married at oldest age
• Person divorced at youngest age
• Person divorced at oldest age
• Youngest father
• Youngest mother
• Oldest father
• Oldest mother
• Couple with most children
• Living couple married most recently
• Living couple married most long ago
• Shortest past marriage
• Longest past marriage

The list is not only interesting on its own, it is also a good sanity
check of the data. For some items you have to fill in some additional
information.

Living couple married most long ago

1. van Dosselaere, Egidius and Rechters, Petronella (382 years, 1 month)
2. de Richter, Petrus and Asscericx, Catharina (379 years, 9 months)

This example shows that there was a marriage event (thus calculation
of the offset) but none of the persons had a death event. Even if the
date is not known, just enter a death event for one of the partners and
the list will be corrected.
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Session Log Gramplet

Fig. 7.16 Session Log Gramplet

The session log keeps track of activity in this session. It lists selected
and edited objects.

Click a name once to make this person the active person. Double-
click on a name or family brings up the edit page for that object. In
addition, if you want to edit a person, but don’t want to change the ac-
tive person, you can right-click on the person’s name.

This gramplet is handy because you can very quickly change the
active person, or edit the object, from the session list.

Statistics Gramplet

Fig. 7.17 Statistics Gramplet

The Statistics gramplet runs a Statistics report. Double-click the phras-
es to bring up the matching items.

Following information is provided to you in this Gramplet:
• Individuals

• Number of individuals
• Males
• Females
• Individuals with unknown gender
• Individuals with incomplete names
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• Individuals with missing birth dates
• Disconnected individuals

• Family information
• Number of families
• Unique surnames

• Media objects
• Individuals with media objects
• Total numbers of media object references
• Number of unique media objects
• Total size of media objects
• Missing Media Objects

As with all Gramplets if you click on the left hand side Tool button
you detach the window and if you add persons to your family tree, you
will see the amount of individuals change dynamically.

Surname Cloud Gramplet
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Fig. 7.18 Surname Cloud

The surname cloud gramplet shows the top 100 (by default) used sur-
names. The name font size is proportional to the amount of people
with the same name.

Double-click a surname to run the Same Surnames Quick View .
This will open the Quick View window where you can find all people
with a matching or alternate name. Person, birth date and name type
are given.

If you mouse over the name you see the percentage of occurrence
and total counts.

Change the number of names displayed by editing this section in
~/.gramps/gramplets.ini
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TODO Gramplet

Fig. 7.19 TODO Gramplet

The TODO gramplet is free form text area. You can use this area to
put some notes, remarks, things you should to get your research go-
ing. There are several other TODO programs (e.g. Tomboy e.a.) but
this Gramplet is useful as the information stays within GRAMPS. In
future versions, you will be able to save links to GRAMPS items (like
people, events, and families. This will allow you to keep a group of
links that you are working on together.

The text is persistent between sessions. The data is saved to disk
when you exit GRAMPS.

You can open more TODO lists to save different kinds of topics or
organize your info.

Change the title of the gramplet by editing the section name in
~/.gramps/gramplets.ini

Top Surnames Gramplet

Fig. 7.20 Top 10 Surnames

The top surnames gramplet shows the top 10 (by default) used sur-
names.

The top ten is presented as follows:
• Surname
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• percentage
• occurrences

The list gives you also the Total unique surnames in the database as
well as the total number of people in your database.

Double-click a surname to run the Same Surnames Quick View .
This opens the Quick View window, which gives the people with the
surname you double-clicked.

A table is presented which shows all people with a matching name
or alternate name. Person’s name, birth date and name type is given.

Change the number of names displayed by editing this section in
~/.gramps/gramplets.ini

Welcome Gramplet

Fig. 7.21 Welcome Gramplet
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The welcome gramplet gives an introductory message to new users,
and some basic instructions.

The welcome message describes what GRAMPS is, that the pro-
gram is OSS and how you start a Family Tree.

This information can also be found on the start page of GRAMPS

What’s Next Gramplet

Fig 7.22 What’s Next Gramplet

The What’s Next Gramplet displays a list of the "most urgent" infor-
mation gaps in your family tree. It is based on the following assump-
tions:
• You want to know first and last name, birth date and place, and

death date and place of each person
• You want to know father, mother, marriage date and place, and -

if divorced - divorce date and place of each family with married
parents

• You want to know at least the mother of each family with
unmarried parents

• The closer the relationship to the main person, the more "urgent"
the information gap is.

• The closer the common ancestor is from the main person, the
more "urgent" the information is (e.g. nephews are considered
more "urgent" than uncles, even though both have a distance of 3,
because for nephews the common ancestor is father/mother, while
for uncles, the common ancestor is grandfather/grandmother)

• Marriage data and personal data of the spouse is slightly less
"urgent" than personal data of the directly related person

• Half brothers are less "urgent" than brothers

Sidebar and bottombar
Since Gramps 3.3 we have common and specific gramplets according
active view (navigation/category).
• Back references gramplets are like the references tab on object

Editor.
• Filter gramplet is like the previous filter sidebar
• Common models for Notes, Gallery, Sources, Events
• Children gramplet on Person views (also ancestry category and

relations), family view
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Person
Attributes Gramplet

Fig. 7.6 Attributes Gramplet

Fig. 7.7 Attributes Quick View

The Attributes gramplet shows all of the attributes for the current, ac-
tive person. Double click on the name of the attribute, and you will run
a Quick View that shows all of the people that have that attribute, and
the values for it. You can sort the Quick View by the attribute value
by clicking on the column name.

In the Quick View, highlight the entry to change the active person
(which will then change the Attributes Gramplet), and double-click
the Quick View entry to bring up the Edit Person dialog window.
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Descendant Gramplet

Fig. 7.9 Descendant Gramplet

The Descendent gramplet shows the direct descendants of the active
person.

The order of the spouses and children is that given in the
GRAMPS editor. To change the order of spouses, click on Order on

the Relationship view. To change the order of children, drag and drop
them in the correct order in the Family edit window.

This gramplet is based on the Descendant Report, available from
the Textual Reports.

The Descendant gramplet will update when you change the active
person, or change family trees. It does not update automatically for ed-
its or additions because this report is time-consuming to run.

Minimizing a gramplet will prevent it from updating.
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Person details

Fan Chart Gramplet

Fig. 7.10 Fan Chart Gramplet

The Fan Chart gramplet shows the direct ancestors of the active person
in a circular format. It is similar to the Pedigree View, but shown
around the center/active person, and further generations spiralling out.

Click on a parent in the chart and they will expand or contract
above their child. Right-click on a person and you can:
• select that person to be the active person
• edit the person
• select from among the person’s relatives to be the active person

Clicking in an open area (non-person) and dragging the mouse will al-
low you to rotate the chart about the center. In Gramps 3.3, you may
also left-click and drag in the center to reposition the fan chart.

A white edge on the outer radius of the chart indicates more par-
ents for that person. A black circle in the center indicates that the cen-
ter person has children.

The Fan Chart gramplet will update when you change the active
person, or change family trees.

Minimizing a gramplet will prevent it from updating.
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Pedigree Gramplet

Fig. 7.12 Pedigree Gramplet

The Pedigree gramplet shows a compressed view of the active per-
son’s direct ancestors. It defaults to going back 100 generations. The
names can be clicked to change the active person, double-clicked (or
right-click) to edit the person. This Gramplet also shows at the bottom
of the gramplet the number of people per generation. Double-click the
Generation number to see the matching individuals.

In GRAMPS 3.3, you can now see birth and death dates next to a
person’s name.

Relatives Gramplet

Fig 7.15 Relatives Gramplet

This Gramplet shows all direct relatives of the active person. It’s in-
tended use is as a navigation help, an alternative way to move through
your GRAMPS database. If you detach the gramplet, and place it next
to GRAMPS, it will allow you to use it to easily change the content of
the current "person view".

If you are working in the ancestry views, the active person is the
left-most person. By clicking a name in the relatives gramplet, you can
easily change the active person, and all person view in the other win-
dow will update. As the relatives gramplet shows all spouses, all chil-
dren and all parents, this offers an alternative way of navigating your
data.

The names in this gramplet also allow you to call up the person
editor directly, by right-clicking on any of the names.
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Place
Place details

Media Object
Preview
Since Gramps 3.3 the preview moved to a gramplet.

Image Metadata
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Fig. Image Metadata Gramplet

Special Note: Before being able to use this gramplet/ addon, you
will need to download and install pyexiv2 or install pyexiv2 from
your local Linux repository. Windows user, there is an installer
for you. Ubuntu, use the Universe repository to find pyexiv2.

The Image Metadata Gramplet offers an easy interface to add, edit,
and remove Image Exif Metadata from your images (*.jpg, *.png.
*.tiff, *.exv, *.nef, *.psd, *.pgf).

Once you have installed pyexiv2, see above for directions to
download and install this addon...

Pyexiv2 can be used from the command line interface (cli) as well,
and from within a python script:
1. import the pyexiv2 library

from pyexiv2 import ImageMetadata, ExifTag

2. specify your image
image = ImageMetadata("/home/user/image.jpg")

3. read the image
image.read()

Exif, IPTC, XMP metadata reference tags can be found here.
Example:

image["Exif.Image.Artist"] # Artist
Smith and Johnson’s Photography Studio

image["Exif.Image.DateTime"] # DateTime
1826 Apr 12 14:00:00

image["Exif.Image.DateTime"] = datetime.datetime.now() # Add
DateTime

image.write() # write the Metadata
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Usage scenario
My perferred way to use this addon is:
1. install pyexiv2
2. Install this addon
3. Install Split Views
4. Restart Gramps
5. Click on Split Views from the left-side Navigation Sidebar
6. Click Views from the Menu bar, and select Media Views
7. Close the right side View by clicking the X at the top left side
8. Slide the available empty right view to about half the screen.
9. Right click in the open space, and select Add a Gramplet

10. Select Image Metadata Gramplet
11. Select an image from the left hand MediaView

The interface
Data Fields
Photographer:

The name of the person or company taking the image

Select Date
Will bring up a calendar, and double-click on a date. The time
will be filled in as the current time

Date
The Date/ Time needs to be typed in as a very specific format:

Year Mon Day Hour:Minutes:Seconds

11826 Apr 12 14:06:00

Copyright

Can be anything that you please... Ex: (C) 2010 Smith and
Wesson

Subject
Please enter keywords that describe the picture. Do NOT add a
space after the comma. Ex. : Census,Milwaukee,Oregon

Latitude/ Longitude
Latitude/ Longitude data can be entered in one of two ways:
1. Degrees Minutes Seconds Ex.: 10 59 14

In this format, you will need to select latitude reference,
and longitude reference

If the Latitude begins with a negative number, select ’S’
as Lat. Ref. or ’N’ if a positive number. If the Longitude
begins with a negative number, select ’W’ as the Long.
Ref. or ’E’ if a positive number.

2. Decimal, Ex. : -34.15954
In this format, the Latitude and Longitude reference will
be selected for you after you click Convert GPS
Coordinates or press the Save button. For foreign
countries that might use a ", " instead of a ".", please use
the "."

Description
Type in something about the image, the people in it or the
location of the image. Non-latin characters are NOT allowed.
ASCII characters only...

Buttons
1. Save

Will write the metadata to the image, and convert latitude/
longitude if it is in decimal format.
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2. Clear
Will clear all data fields

3. Convert GPS Coordinates
will convert Latitude/ Longitude if it is in decimal format

My favorite source for GPS Coordinates is: GPS Visualizer

Previous Index Next
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Gramps 3.3 Wiki Manual - Reports

This section describes all the different reports available in GRAMPS.

Previous Index Next

Special copyright notice: All edits to this page need to be
under two different copyright licenses:
• GNU Free Documentation License 1.2 - see wiki

copyright
• GPL - see manual copyright

These licenses allow the Gramps project to maximally use
this wiki manual as free content in future Gramps versions.
If you do not agree with this dual license, then do not edit
this page. You may only link to other pages within the wi-
ki which fall only under the GFDL license via external
links (using the syntax: [http://www.gramps-project.org/
...]), not via internal links.
Also, only use the known conventions

Introduction
The amount of available reports in GRAMPS is huge and could be
overwhelming at first glance. The different subsections describe the
various possibilities and options:

Additional Reports
Starting with Gramps version 3.3 a new
system was implemented to have even
more reports available. This system is
controlled by the Plugin Manager. The
Plugin Manager can get additional Ad-
dons for you. Check the list of the avail-
able reports here.

Generating Reports: This first subsection gives you some general
remarks.

Substitution Values: you can use some handy values in your re-
ports.

Books
The book report creates a single document containing a collection of
graphical and textual reports.

Graphical Reports
Graphical reports represent information in forms of charts and graphs.
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Ancestor Tree
The Ancestor Tree report generates the chart of people who are ances-
tors of the Active Person.

Calendar
The Calendar report produces a calendar with birthdays and anniver-
saries on a page by month.

Descendant Tree
The Descendant Tree report generates a graph of people who are de-
scendants of the Active Person.

Family Descendant Tree
The Family Descendant Tree generates a graph of people who are de-
scendants of the Active Family.

Fan Chart
The Fan Chart report produces a chart resembling a fan, with Active
Person in the center, parents the semicircle next to it, ans so on, for a
total of five generations.

Statistics Chart
The Statistics Chart report can collect and display a wealth of statisti-
cal data about your database.

Timeline Chart
The Timeline Chart report outputs the list of people with their life-
times represented by intervals on a common chronological scale.

Graphs
These reports are related to GraphViz.

Family Lines Graph
The Family Lines Graph.py plugin was created to generate easy-to-
follow graphs. Note that FamilyLines does not display all of the peo-
ple in the database -- instead, this plugin generates smaller family
trees, with many options to try and restrict the number of people in-
cluded. A typical use of this plugin is to generate simplified graphs
printed on large plotters.

Hourglass Graph
The Hourglass Graph generate an hourglass graph using the GraphViz
generator.

Relationship Graph
The Relationship Graph creates a complex relationship graph in
GraphViz format and then converts into graphical output running it
through the GraphViz dot tool behind the scene.

Text Reports
Text reports represent the desired information as formatted text.

Ahnentafel Report
The Ahnentafel Report lists the Active Person and his or her ancestors
along with their vital data. The people are numbered in an establish
standard called ’Ahnentafel’.
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Birthday and Anniversary Report
The Birthday and Anniversary Report gives the same information as a
calendar but in text format.

Complete Individual Report
The Complete Individual Report provides individual summaries simi-
lar to that of the Individual Summary Report.

Descendent Report
The Descendant Report presents the descendants of the Active Person
with a brief description in intended style.

Detailed Ancestral Report
The Detailed Ancestral Report covers in detail the ancestors of the Ac-
tive Person, including a range of vital data as well as marriages.

Detailed Descendant Report
The Detailed Descendant Report covers in detail the descendants of
the Active Person by generation, following the genealogical tradition
of textual descendant reports by generation. It aims to provide all im-
portant features expected to be found in these classic descendency for-
mats and has received influence from various sources.

End of Line Report
The End of Line Report provides a list of of the person’s last known
ancestors with the pedigree line, ordered by generations.

Family Group Report
The Family Group Report creates a family group report, showing in-
formation on a set of parents and their children.

Kinship Report
Kinship Report provides the kinship of selected person according to
level search( hight, down generations) set by the user.

Tag Report
The Tag Report lists primary objects - persons, families, and notes -
who match the selected tag. (It was formerly called the "marker re-
port" in 3.2 gramps.)

Number of Ancestors
The Number of Ancestors displays the number of ancestors of the Ac-
tive Person. The form is - generation x has y individuals (z %).

Place Report
The Place Report produces a report according to places selected by the
user. It will list related person and event to the selected place.

Records Report
Records Report shows a number of interesting records(mostly age re-
lated) in your database, like oldest living person, youngest mother,etc.

Summary of the Database
The Summary of the Database displays the overall statistics concern-
ing number of individuals of each gender, various incomplete entries
statistics, as well as family and media statistics.
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Web Pages and Quick Reports
Web Pages
Narrated Web Site
One of the reports in this category is the Narrated Web Site report. It
generates a web site (that is, a set of linked web pages), for a set of
selected individuals.

Web Calendar
Web Calendar

Quick Reports
Quick reports are reports that are available in the context menu’s of
person, family, ... They are easy to make by users, even with limited
coding knowledge.

Previous Index Next
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Gramps 3.3 Wiki Manual - Tools

This chapter describes the various tools available in GRAMPS.
GRAMPS tools allow you to perform various types of analysis of

your genealogical data. Typically, the tools do not produce output in
form of printouts or files. Instead, they produce screen output imme-
diately available for the researcher. However, when appropriate, you
can save the results of running a tool into a file. Tools present one of
the major strengths of GRAMPS compared to the most genealogical
software.

The tools can be accessed through the menu by choosing Tools -
>Tool Section ->Particular Tool . Alternatively, you can browse the
complete selection of available tools along with their brief descrip-
tions in a Tool Selection dialog invoked by clicking the Tools icon on
the toolbar.

Special copyright notice: All edits to this page need to be
under two different copyright licenses:
• GNU Free Documentation License 1.2 - see wiki

copyright
• GPL - see manual copyright

These licenses allow the Gramps project to maximally use
this wiki manual as free content in future Gramps versions.
If you do not agree with this dual license, then do not edit
this page. You may only link to other pages within the wi-
ki which fall only under the GFDL license via external
links (using the syntax: [http://www.gramps-project.org/
...]), not via internal links.
Also, only use the known conventions

Previous Index Next

Introduction

Additional Tools
Starting with Gramps version 3.3 a new
system was implemented to have even
more tools available. This system is con-
trolled by the Plugin Manager. The Plu-
gin Manager can get additional Addons
for you. Check the list of the available
tools here.

Common Options
• id: = ID

Gramps ID of a central person.

Analysis and Exploration
This section contains tools which analyze and explore the database,
but do not alter it. The following analysis and exploration tools are
currently available in GRAMPS:
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Compare Individual Events...
This tool compares events across the selected group of people. The
people for this comparison are chosen with the use of custom filters.
The custom filters can be created in the Custom Filter Editor (see
tools-util-cfe ) that can be invoked by clicking the Custom Filter Edi-
tor button. The resulting table produced by this tool can be saved as a
spreadsheet.

Interactive Descendant Browser...

Fig. 9.1 Descendant Browser

First you have to select a person or you start with the current Active
Person.

Click on the menu Tools-->Analysis and Exploration-->Interac-
tive Descendant Browser.

This tool builds a tree with the Active Person being the root. Chil-
dren branch from their parents in the usual manner.

You can click the down or > buttons to expand or collapse the
nodes.

Use this tool for a quick glance of a person’s descendants.

Tip
Double-clicking on tree node will bring
up the Edit Person dialog allowing to
view or modify the personal data.

The Help button will bring you to this page and with the Close you
close the Descendant Browser window.

Database Processing
This section contains tools which may modify your database. The
tools from this section are used mostly for finding and correcting er-
rors in the data. The following database processing tools are currently
available in GRAMPS:

Note
The modifications will only be performed
upon your explicit consent, except for the
automatic fixes performed by Check and
repair Database tool.
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Edit Database Owner Information

Fig. 4.3 Owner Info

click Tools-->Database Processing-->Edit Database Owner infor-
mation. This brings up the Database Owner editor window, where
you can fill in the needed info.
• Name:
• Adress:
• City:

• State/Province:
• Country:
• ZIP/Postal Code:
• Phone:
• Email:

Extract Information from Names
This tool searches the entire database and attempts to extract titles and
nicknames that may be embedded in a person’s Given name field. If
any information could be extracted, the candidates for fixing will be
presented in the table. You may then decide which to repair as sug-
gested and which not to.

Extract Place Data from a Place Title

Extract Place Data

This tool attempts to extract city, state/province and zip code from a
place title. The tools operates on places where all fields in the main
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location are empty. The description must match the following cate-
gories:

New York, NY 10000

Only available for :
• USA
• Canada
• Sweden

Stockholm (A)

• France

Paris, IDF 75000, FRA or Paris, ILE DE FRANCE 75000, FRA

The dialog allows you to preview and confirm individual changes.

Extract Event Descriptions from Event Data
Extracts event descriptions from the event data by using a model :

{event type} of {Surname}, {Given name}

If event description is missing, then tool will use this event description
field model.

Find Possible Duplicate People...

Fig. 4.4 Duplicate People

This tool searches the entire database, looking for the entries that may
represent the same person.

You can access this tool via Tool->Database Processing...->Find
Possible Duplicate People....

Two options are available:
• Match Threshold: choose between High, Medium and Low from

the drop down menu.
• Options: a check box to enable or disable the use of soundex

codes.
Only three buttons are present: Help brings you to this page, a Cancel
to stop processing and an OK button to start processing the data.

If you hit the OK button, the data will be processes in two passes.
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Pass 1: building preliminary lists Pass 2: calculating potential
matches. A progress bar will be shown and depending the speed of the
cpu and the amount of people in the database this can take some time.

Finally a Potential Merges window is presented. This window
shows a list with three columns:
• Rating: this gives you an idea of the resemblance between the two

people. The higher the ranking, the higher the chance that the
people are duplicates.

• First Person
• Second Person

If you select a row you can check the details with the Compare button
or you can double-click on the selected row.

Three buttons are present: Help brings you to this page, a Close to
close the window and a Compare button to which brings up a Com-
pare People window which was explain in detail in the Merge People
Dialog. Here you can select with the radio buttons one of the persons
and eventually use the Merge and close button to merge the data if
you find the two persons are duplicates.

Hitting the Cancel button brings you back to the list.

Fix Capitalization of Family Names...

Fig. 4.5 Fix Capitalization

This tool searches the entire database and attempts to fix the capital-
ization of family names.

The aim is to have conventional capitalization: capital first letter
and lower case for the rest of the family name. If deviations from this
rule are detected, the candidates for fixing will be presented in the
table.

You may then decide which to repair as suggested and which not
to.

You can use this tool via Tools-->Database Processing-->Fix
Capitalization of Family Names....
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Undo history
Proceeding with this tool will erase the
undo history for this session. In particu-
lar, you will not be able to revert the
changes made by this tool or any
changes made prior to it. If you think
you may want to revert running this
tool, please stop here and backup your
database.

You can choose Stop or Proceed with the tool .
If there where changes to Capitalization of Names you will be pre-

sented with the Capitalization changes window. The window shows
a list of the family names that GRAMPS can convert to correct capital-
ization. In the list you will see a three columns: Select check box(es),
Original Name and Capitalization Change.

Select the names you want to be changed, then hit the Accept
changes and close button. Or use the Cancel button to abort changes.

Rename Event Types

Fig. 4.6 Change type

This tool allows all the events of a certain name to be renamed to a
new name.

Undo history
Proceeding with this tool will erase the
undo history for this session. In particu-
lar, you will not be able to revert the
changes made by this tool or any
changes made prior to it. If you think
you may want to revert running this
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tool, please stop here and backup your
database.

The Change Event Types window is presented. This tool will rename
all events of one type to a different type.
• Original event type: fill in the text field or use the drop down

menu and select an original event type
• New event type: fill in the text field (you can create a complete

new type here) or use the drop down menu and select a new type
The example shows a renaming of the Birth event to a Baptism event.

Finally use the Cancel or the OK button.

Renaming events
Once completed, this cannot be undone
by the regular Undo function.

Reorder GRAMPS ID
This tool reorders will change all the elements in the database to con-
form to the scheme specified in the database’s prefix id’s.

You can change those settings in the Edit-->Preferences...-->ID
Formats menu.

You can use this tool via Tools-->Database Processing-->Reor-
der GRAMPS IDs.

Undo history
Proceeding with this tool will erase the
undo history for this session. In particu-
lar, you will not be able to revert the
changes made by this tool or any
changes made prior to it. If you think
you may want to revert running this

tool, please stop here and backup your
database.

The window will show a progress bar.
In different steps following IDs’ are reordered: Reordering People

IDs’, Reordering Family IDs’, Reordering Event IDs’, Reordering
Media Object IDs’, Reordering Source IDs’, Reordering Place IDs’,
Reordering Repository IDs’ and finally Reordering Note IDs’.

In a next step unused IDs’ are searched for and assigned.

Custom IDs’
If you customized your IDs’, all those
setting are replaced by the default set-
ting. So take care before you use this
tool!
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Sort Events

Fig. 4.7 Sort Events

Events appearing on the Event tab on a Person or Family Editor are
not sorted in any particular order other than the order that the events
were added. The reason for not enforcing any particular ordering, par-
ticularly ordering by date, is to allow for the situation where an event
was known to have happened but the exact chronology is not. Import-
ing or merging data from an external source can lead to extra events
being added to, but out of sequence with, the existing set of events of
a person or family.

Events can be manually re-ordered by drag & drop or by use of
the re-order buttons on the Events tab. Either way, an event can be
moved up or down in the list of events and Gramps will remember the

new order when the changes are saved. The new ordering will be used
wherever events are shown elsewhere in Gramps, such as on a report.

The order of all events on a tab can also be changed by clicking
a column title. For example, clicking the ’Date’ column header will
sort all the events in date order. However this way of sorting events is
temporary and changes to the event order are not preserved when the
window is closed.

The drag and drop approach to sorting events is fine for moving
a small number of events but is not practical for large scale changes.
The Sort Events tool has been designed specifically for this purpose,
re-sorting all events in the database or just those associated with a tar-
geted selection of people chosen by using a filter.

The first option on the Sort Events dialog window is used to define
the range of people who’s events are to be sorted. The first choice in
the list is to apply the sorting to all people in the database. Alternative
choices are to apply sorting to ancestors and descendants of a chosen
person or to a range of people selected by a custom built person filter.
After choosing who the sort should apply to, the next thing to consider
is how the events should be sorted. The first option is to sort by date.
This is probably the most likely choice, but other event attributes can
be chosen too. The final choices are whether to make the events sorted
ascending or descending and whether to apply the sort to family events
that the selected people belong to as well.

Undo history
Proceeding with this tool will erase the
undo history for this session. In particu-
lar, you will not be able to revert the
changes made by this tool or any
changes made prior to it. If you think
you may want to revert running this
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tool, please stop here and backup your
database.

Sorting events
Once completed, this cannot be undone
by the regular Undo function.

Database Repair
Check and repair database
This tool checks the database for integrity problems, fixing the prob-
lems it can. Specifically, the tool is checking for:
• Broken family links. These are the cases when a person’s record

refers to a family while the family’s record does not refer to that
person, and vice versa.

• Missing media objects. The missing media object is the object
whose file is referenced in the database but does not exist. This
can happen when the file is accidentally deleted, renamed, or
moved to another location.

• Empty families. These are the family entries which have no
reference to any person as their member.

• Parent relationship. This checks all families to ensure that father
and mother are not mixed up. The check is also made that parents
have different gender. If they have common gender then their
relationship is renamed to "Partners".

Rebuild Reference Maps
This tool rebuilds reference map tables (References items on editors).

Rebuild Secondary Indices
This tool rebuilds secondary indices.

Remove Unused Objects...
This tool will search your database for pieces of information which are
not connected to anything else, and then remove them.

Utilities
This section contains tools allowing you to perform a simple operation
on a portion of data. The results can be saved in your database, but
they will not modify your existing data. The following utilities are cur-
rently available in GRAMPS:

Generate SoundEx codes

SoundEx what is this?
This utility generates SoundEx codes for the names of people in the
database. Please visit the NARA Soundex Indexing page to learn more
about Soundex Indexing System.

The soundex is a coded surname (last name) index based on the
way a surname sounds rather than the way it is spelled. Surnames that
sound the same, but are spelled differently, like SMITH and SMYTH,
have the same code and are filed together. The soundex coding system
was developed so that you can find a surname even though it may have
been recorded under various spellings.

First applied to the 1880 census, Soundex is a phonetic index, not
a strictly alphabetical one. Its key feature is that it codes surnames
(last names) based on the way a name sounds rather than on how it is
spelled. It was to help researchers find a surname quickly even though
it may have received different spellings.

Those doing census lookups must use the same method to encode
surnames as the census takers did when they generated the database.

To search for a particular surname, you must first work out its
code.
•

From Gramps Gramps 3.3 Wiki Manual - Tools

9

wiki/index.php?title=File:Gnome-important.png
wiki/index.php?title=File:Gnome-important.png


Every soundex code consists of a letter and three numbers, such as
W-252. The letter is always the first letter of the surname. The num-
bers are assigned to the remaining letters of the surname according to
the soundex guide shown below. Zeroes are added at the end if neces-
sary to produce a four-character code. Additional letters are disregard-
ed. Examples: Washington is coded W-252 (W, 2 for the S, 5 for the
N, 2 for the G, remaining letters disregarded). Lee is coded L-000 (L,
000 added).

Number Represents the Letters
1 B, F, P, V
2 C, G, J, K, Q, S, X, Z
3 D, T
4 L
5 M, N
6 R

Disregard the letters A, E, I, O, U, H, W, and Y.
•
• • Names With Double Letters: If the surname has any double

letters, they should be treated as one letter. For example:
Gutierrez is coded G-362 (G, 3 for the T, 6 for the first R, second R
ignored, 2 for the Z).
• • Names with Letters Side-by-Side that have the Same Soundex

Code Number: If the surname has different letters side-by-
side that have the same number in the soundex coding guide,
they should be treated as one letter. Examples:
• Pfister is coded as P-236 (P, F ignored, 2 for the S, 3 for

the T, 6 for the R).
• Jackson is coded as J-250 (J, 2 for the C, K ignored, S

ignored, 5 for the N, 0 added).

• Tymczak is coded as T-522 (T, 5 for the M, 2 for the C, Z
ignored, 2 for the K). Since the vowel "A" separates the Z
and K, the K is coded.

• • Names with Prefixes: If a surname has a prefix, such as Van,
Con, De, Di, La, or Le, code both with and without the prefix
because the surname might be listed under either code. Note,
however, that Mc and Mac are not considered prefixes.For
example, VanDeusen might be coded two ways:V-532 (V, 5
for N, 3 for D, 2 for S) or D-250 (D, 2 for the S, 5 for the N, 0
added).

• • Consonant Separators: If a vowel (A, E, I, O, U) separates
two consonants that have the same soundex code, the
consonant to the right of the vowel is coded.
Example:Tymczak is coded as T-522 (T, 5 for the M, 2 for
the C, Z ignored (see "Side-by-Side" rule above), 2 for the K).
Since the vowel "A" separates the Z and K, the K is coded. If
"H" or "W" separate two consonants that have the same
soundex code, the consonant to the right of the vowel is not
coded. Example: Ashcraft is coded A-261 (A, 2 for the S, C
ignored, 6 for the R, 1 for the F). It is not coded A-226.
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Use of SoundEx module in GRAMPS

Fig. 4.8 SoundEx code generator

Clicking via the Toolbar on Tools-->Utilities --> Soundex gener-
ator... you get the SoundEx code generator window. In the Name
text field you can type in a name or you could use the down arrow
where you can should a name from the drop down list.

The name you put in can by any name even a name not present in
your Family Tree.

The result is shown automatically: R236
A Help button is available which brings you to this page. With the

Close button (or hitting <alt+c>) you close this generator window.

Media Manager...

Fig. 4.9 Final confirmation window

This tool allows batch operations on media objects stored in
GRAMPS. An important distinction must be made between a
GRAMPS media object and its file.

The GRAMPS media object is a collection of data about the media
object file: its filename and/or path, its description, its ID, notes,
source references, etc. These data do not include the file itself.

The files containing image, sound, video, etc. exist separately on
your hard drive. These files are not managed by GRAMPS and are
not included in the GRAMPS database. The GRAMPS database only
stores the path and file names.

This tool allows you to only modify the records within your
GRAMPS database. If you want to move or rename the files then you
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need to do it on your own, outside of GRAMPS. Then you can adjust
the paths using this tool so that th media objects store the correct file
locations.

If you click the Forward button (or hit <Alt+F>) you will get a
window with three radio buttons:
• Replace substrings in the path: Selecting this radio button will

bring up a Replace substring settings window where you can
type in any string in the Replace text field and the With text
field. At any time you can click on the Cancel button or the
Back button. Clicking the Forward button will bring up the
Final confirmation window.

• Convert paths from relative to absolute
• Convert paths from absolute to relative

Not Related

Fig. 4.10 Not related

This report will find people who are not related to the selected person.
You will get a Not related to ’...’ window which shows a list of

all the people that are NOT related to the selected person.

This list gives you:
• Name
• ID
• Parents
• Marker

With the right arrow button and down arrow button you can collapse
or expand the list. Double clicking on a person will bring up the de-
tailed person edit window or family edit window.

If you select a person you can use the Marker text field: 3 choices
are possible: blank (you can fill in whatever suits you), TODO, and
NotRelated. With the Apply you can apply the selected marker to the
person. This marker will then show up in the right hand side column.

Relationship calculator
This utility calculates and displays the relationship of any person to
the Active Person.
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Verify the Data...

Fig. 4.11 Verify the Data...

This utility allows you to verify the database based on the set of crite-
ria specified by you.

For example, you may want to make sure that nobody in your data-
base had children at the age of 98. Based on common sense, such a

record would indicate an error. However, it is not a consistency error
in the database. Besides, someone might have a child at the age of 98
(although this rarely happens). The Verify tool will display everything
that violates your criteria so that you can check whether the record is
erroneous or not. The ultimate decision is yours.

Clicking on Tools-->Utilities-->Verify the Data... you will get a
Database Verify Tool window. The window has four tabs. Those tabs
show a list with criteria and a input field where you can alter the crite-
ria value. In the lists below I show some workable values.
• :

• maximum age: 95
• minimum age to marry 16
• maximum age to marry 60
• maximum spouses for a person 4
• maximum number of consecutive years of widowhood before

next marriage 30
• maximum age for an unmarried person 99

There is a check box: estimate missing dates. This causes the tool to
accept a baptism date if a birth date is not known, and to accept a bur-
ial date if a death date is not known. In addition, starting in gramps
version 3.3.0, it also causes the tool to accept "inexact" dates (i.e., any
"legal" gramps date which is not a fully-specified one (with an explicit
day and month and year)).
• :

• minimum age to bear a child 16
• maximum age to bear a child 51
• maximum number of children 15

• • minimum age to father a child 18
• maximum age to father a child 65
• maximum number of children 15

• • maximum husband-wife age difference 41
• maximum number of years between children 11
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• maximum span of years for all children 32

If you are OK with the criteria click the Run button (or hit <Alt+R>
and you will be presented with a Database Verification Results win-
dow.

Depending on your criteria and your data a list will be shown.
Some possibilities of findings are listed below. But there are others.
• Disconnected individuals (ones with no parent or spouse or child

or sibling)
• old/dead father
• marriage after death/ before birth
• large year span for all children
• early/late marriage
• young/unborn mother
• husband and wife with the same surname
• same sex marriage/ female husband
• ...

To show how handy this Utility is, here two live examples from real
data:

The warning showed ’female husband’: checking the data I found
a family with father : Anna Roelants. Luckily in the Description I
read: The marriage of Adam Roelants and Cornelia Crabbe. It was
clearly a typo: Anna i.s.o. Adam. Without this Tool it would be very
hard to find.

The warning showed ’late marriage’: checking the data: male per-
son °1738 female person °1756 : marriage X 1804 [Gregorian Calen-
der] : Everything seemed to be OK: so they (re)married at the age of
66 and 48 years! The warning showed up because the General crite-
ria was set to 60.

On the bottom of the window four check boxes are available to
make a selection easier. Those are Mark All , Unmark All , Invert
Marks , and Hide Marked .

Double-clicking on a row will give you a possibility to view and
or edit the data.

With the Close button (or hit <Alt+C>) you close the Results win-
dow. With the Help button (or hitting <Alt+H>) you will get to this
page.

Difference between Verify tool
and previously described Check
tool
The Check tool detects inconsistencies
in the database structure. The Verify
tool,however, is detecting the records
that do not satisfy your particular crite-
ria.

For example, you may want to make sure that nobody in your database
had children at the age of 98. Based on common sense, such a record
would indicate an error. However, it is not a consistency error in the
database. Besides, someone might have a child at the age of 98 (al-
though this rarely happens). The Verify tool will display everything
that violates your criteria so that you can check whether the record is
erroneous or not. The ultimate decision is yours.

Previous Index Next
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Gramps 3.3 Wiki Manual - Settings

Special copyright notice: All edits to this page need to be
under two different copyright licenses:
• GNU Free Documentation License 1.2 - see wiki

copyright
• GPL - see manual copyright

These licenses allow the Gramps project to maximally use
this wiki manual as free content in future Gramps versions.
If you do not agree with this dual license, then do not edit
this page. You may only link to other pages within the wi-
ki which fall only under the GFDL license via external
links (using the syntax: [http://www.gramps-project.org/
...]), not via internal links.
Also, only use the known conventions

Previous Index Next

Preferences
Most of the settings in GRAMPS, are configured in the Preferences
dialog. To invoke it, choose Edit ->Preferences... .

Fig. 10.1 General Preferences

The tabs on the top display the available option categories.

General
This category contains preferences relevant to the general operation of
the program. Options are:
• Add default source on import: This option affects the importing

of data. If this is set, each item that is imported will contain a
source reference to the imported file.

Note
Adding a default source can significantly
slow down the importing your data.

• Enable spelling checker: This option controls the enabling and
disabling of the spelling checker for notes. The package must be
loaded for this to have an effect.
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• Display Tip of the Day: This option controls the enabling and
disabling of the Tip of the Day dialog at startup.

• Use shading in Relationship View: This option controls the
enabling and disabling of shading in the Relationship View. If
enabled, information will be grouped together in regions with a
shaded background.

• Display edit buttons on Realtionship View: This option controls
the enabling and disabling of the edit buttons in the Relationship
view. If enabled you will see the edit buttons on the right side of
the displayed names.

• Remember last view displayed: This option controls the enabling
and disabling of the the display of the last view. Enabling will
bring you to the view where you stopped the program the last
time.

• Number of generations for relationship determination: You can
fill in the number of generations used to determine relationships.
The default value is .

• Base path for relative media path: Here you can fill in a base path
for the media objects. Clicking the Directory button gives you a
Select media directory editor where you can fill in the required
path.

Database

Fig. 10.2 Database Preferences

This category contains preferences relevant to the Database path.
• Database path: The default path where the Databases are stored is

. Unless you absolutely want to change this, stay with the default
path.

• Automatically load last database: This option controls the
enabling and disabling of the loading on start up of the last used
database.
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Display

Fig. 10.3 Display Preferences

This category contains preferences relevant to the display of data and
names. Options are:
• Name format: This option controls the display of names. In

GRAMPS there are two type of name display formats: the
predefined formats, and the user defined custom formats. Several
different predefined name formats are available: Given - Prefix
Patronymic, Suffix Given - Prefix Surname, Given Patronymic
Suffix etc. Clicking on the righthand side Edit... will bring up a
Display Name Editor window where the available list of options
is shown. The format is given as well as an example. When
predefined formats are not suitable one can define one’s own
format. You can use the Add button to add a Name format to the
list. Clicking once will give you a SURNAME,Given
Suffix(call) format and as example : SMITH, Edwin Jose Sr
(Ed). If you added new name formats to the list the Remove and
Edit buttons become available to change the name format list.

Note
Besides the system wide setting
GRAMPS allows deciding the name dis-
play format individually for every single
name via the Name Editor dialog (see
adv-an ).

Note
Custom name display formats are stored
in the databases, thus before loading any
database the Custom format details ex-
pander is disabled.

• Date format: This option controls the display of dates. Several
different formats are available, (e.g. YYYY-MM-DD (ISO))
which may be dependent on your locale.

• Calendar on reports: This option controls the display of calendar
on reports, tools, gramplets, views. Several different calendars are
available (see Date Edition). Two dates with two differents
calendars will not properly display timeline or periode, (e.g. by
setting Gregorian calendar as default displayed calendar, users
will have a better coherency for displaying dates on period).

• Surname Guessing: This option affects the initial family name of
a child when he/she is added to the database. If None is selected,
no guessing will be attempted. Selecting Father’s surname will
use the family name of the father. Selecting Combination of
mother’s and father’s surname will use the father’s name
followed by the mother’s name. Finally, Icelandic style will use
the father’s given name followed by the "sson" suffix (e.g. the
son of Edwin will be guessed as Edwinsson).
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Tip
This option only affects the initial fami-
ly name guessed by GRAMPS when the
Edit Person dialog is launched. You
can modify that name the way you see
fit. Set this option to the value that you
will most frequently use, as it will save
you a lot of typing.

• Status bar: This option controls the information displayed in the
status bar. This can be either the Active person’s name and ID or
Relationship to home person.

• Show text in sidebar buttons: This option controls whether or not
a text description is displayed next to the icon in the sidebar. This
option takes effect after the program has been restarted.

Text

Fig. 10.4 Text Preferences

This category contains preferences relevant to how missing and pri-
vate names and records should be shown.
• Missing surname: in the input field you can determine how a

missing surname should be displayed. Default value is . You can
change this to [--] or whatever is most convenient for you.

• Missing given name: in the input field you can determine how a
missing given name should be displayed. Default value is . You
can change this to whatever you want.

• Missing record
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• Private surname
• Private given name
• Private record

Dates

Fig. 10.5 Dates Preferences

ID Formats

Fig. 10.6 ID Format Preferences

This category contains preferences relevant to the automatic genera-
tion of GRAMPS IDs.
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• Person: Provides the template for generating IDs for a Person.
Default value: I%04d.

• Family: Provides the template for generating IDs for a Family.
Default value: F%04d.

• Place: Provides the template for generating IDs for a Place.
Default value: P%04d.

• Source: Provides the template for generating IDs for a Source.
Default value: S%04d.

• Media Object: Provides the template for generating IDs for a
Media Object. Default value: O%04d.

• Event: Provides the template for generating IDs for an Event.
Default value: E%04d.

• Repository: Provides the template for generating IDs for a
Repository. Default value: R%04d.

• Note: Provides the template for generating IDs for a Note.
Default value: N%04d.

ID Prefixes
The ID prefixes use formatting conven-
tions common for C, Python, and other
programming languages. For example,
the %04d expands to an integer,
prepended with zeros to have the total
width of four digits. If you would like
IDs to be 1, 2, 3, etc., simply set the for-
matting parameter to %d.

Warnings

Fig. 10.7 Warning Preferences

This category controls the display of warning dialogs, allowing the re-
enabling of dialogs that have been disabled.
• Suppress warning when adding parents to a child:
• Suppress warning when cancelling with changed data
• Suppress warning about missing researcher when exporting to

GEDCOM
• Show plugin status dialog on plugin load error
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Researcher Information

Fig. 10.8 Researcher Preferences

Enter your personal information in the corresponding text entry fields.
Although GRAMPS requests information about you, this information
is used only so that GRAMPS can create valid GEDCOM output files.
A valid GEDCOM file requires information about the file’s creator. If
you choose, you may leave the information empty, however none of
your exported GEDCOM files will be valid.

The available text entry fields are:
• Name:
• Address:
• City:
• State/Province:
• Country:
• ZIP/Postal Code:
• Phone:

• Email:

Marker Colors

Fig. 10.9 Marker Colors Preferences

This category controls the highlight color of items in the list when a
marker has been set for a person, family or note.

You can choose a different color for:
• Complete: default color Green: #008B00
• ToDo: default color Red: #F00
• Custom: default color Purple: 8B008B

Clicking on the colored boxes brings up an Pick a Color editor where
you can change the default settings. The color name can be changed
by typing in the name of a color: e.g. Beige.

Clicking the Revert button will undo the changes.
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Other settings
Besides Preferences dialog, there are other settings available in
GRAMPS. For various reasons they have been made more readily ac-
cessible, as listed below.

Column Editor

Fig. 10.11 Column editor

The columns of the list views may be added, removed, or reordered in
a Column Editor dialog. Only checked columns will be shown in the
view. To change their order, drag any column to its desired place in-
side the editor. Clicking OK will reflect the changes in the appropriate
view. To invoke Column Editor dialog, choose View -> Configure...
or click on Configure button.

Column Editor
The Column Editor is available and
works in the same way for all list views.
Specifically, it is available for People
View, Family View (children list).
Sources View, Places View, Media
View, Repositories View and the Notes
View.

Setting Home person
The Home person is the person who becomes active when database
opened, when Home button is clicked or the Home menu item is se-
lected from either Go menu or the right-click context menu anywhere.
The Home button is available in the Toolbar in the People View, Re-
lationships View, and Pedigree View. To set Home person, make the
desired person active and then choose Edit ->Set Home person... .

Adjusting viewing controls
Whether the toolbar, the sidebar, or the filter (not available on Pedi-
gree and Relationships Views) are displayed in the main window is
adjusted through the View menu. In the different views clicking the
View menu will shows for boxes you can click:
• Navigator
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• Toolbar
• Sidebar
• Bottombar
• Full Screen F11

Additionally, depending on the view you are in, other options will be
available on Configure .
• Gramplets:

• Set Columns to 1
• Set Columns to 2
• Set Columns to 3

• Relationships:
• Show Siblings
• Show Details

• Geography:
• Time period
• Layout

All other Views: the column editor.

Export the screen

Fig. 10.12 Export to ODS

On most Views, displayed data could be exported, choose Family
Trees ->Export View... . GRAMPS will export data on screen accord-
ing your choice: CSV or Open Document spreadsheet format. The
example shows an export to Ods. This is a powerful function (no lim-
itations), like a report.

Modularity and plugins
Views are now real "plugins". Gramps 3.3 is more modular and flexi-
ble.

See plugins manager and Addons.

Fig. The plugins manager
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Fig. Ability to hide plugins

Advanced manipulation of settings

Warning
The contents of this section is outside
the scope of interest of a general user of
GRAMPS. If you proceed with tweak-
ing the options on the low level you
may damage your GRAMPS installa-
tion. Be careful. YOU HAVE BEEN
WARNED!

Fig. 10.13 The keys.ini file

GRAMPS 3 uses INI keys stored under .gramps (gramplets, keys)
for managing user preferences. The list has following sub-items:
• behavior: typical Key names are: betawarn, enable-autobackup,

use-tips...
• export: export and import dirs
• interface: a lot of keys regarding height and width of the different

Views: e.g. event-height: 450, event-ref-height: 585, event-ref-
width: 728, event-width: 712...

• paths: keys related to recent imported files and dirs
• preferences: keys related to preferences: all the common prefixes

, todo -colors..
• researcher: all information regarding the researcher
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Name Format Editor
New formats are created, and existing formats are modified using this
editor.
• Format name: The name of the custom format. The format name

can be any string, it is used only to recognize the format later on
the Display format list.

• Format definition: The actual format is defined here using special
formatting characters. Before and after these special characters
any other character or string is allowed. For example:
"(%t) %L, %f" will give "(Dr.) SMITH, Edwin". The
formatting characters are:

Character Name CHARACTER NAME
%f Given Name %F GIVEN NAME
%l Surname %L SURNAME
%t Title %T TITLE
%p Prefix %P- PREFIX
%s- Suffix %S SUFFIX
%c Call name %C CALL NAME
%y Patronymic %Y PATRONYMIC

• Example: Shows a dynamic example how the name will be
displayed with the current Format definition string.

• Format definition details: Shows a quick reminder of the special
formatting characters.

Previous Index Next
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Gramps 3.3 Wiki Manual - Filters

This appendix lists of all the filter rules currently defined in
GRAMPS. Each of these rules is available for use when creating cus-
tom filters, see tools-util-cfe . The rules are listed by their categories.

Special copyright notice: All edits to this page need to be
under two different copyright licenses:
• GNU Free Documentation License 1.2 - see wiki

copyright
• GPL - see manual copyright

These licenses allow the Gramps project to maximally use
this wiki manual as free content in future Gramps versions.
If you do not agree with this dual license, then do not edit
this page. You may only link to other pages within the wi-
ki which fall only under the GFDL license via external
links (using the syntax: [http://www.gramps-project.org/
...]), not via internal links.
Also, only use the known conventions

Previous Index Next

You can carry out a considerable amount of selection of persons,
events, places, etc., just using the Filter Sidebar in Person, Event,
Place,etc. Views; but note, however, that the ’Use regular expressions’
option only works with particular fields in each View.

If the Filter Sidebar is inadequate for your purpose, you will need
to build custom filters.

Custom Filter Editor

Fig.11.1 Define filter

The Custom Filter Editor builds custom filters that can be used to se-
lect people included in reports, exports, and other tools and utilities.
This is in fact a very powerful tool in genealogical analysis.
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When you launch it, the User defined filters dialog appears that
lists all the filters (if any) previously defined by you. Click the Add...
button to define a new filter. Once you have designed your filters, you
can edit, test, and delete selected filters using the Edit... , Test... , and
Delete buttons, respectively. All the filters displayed in the list will
be automatically saved along with your database and will be available
with subsequent sessions of GRAMPS.

Changes on filters
The changes made to the filters only take
effect when you click the Apply and
close button.

Clicking the Add... button invokes the following Define filter dialog:

Type the name for your new filter into the Name field.
Enter any comment that would help you identify this filter in the

future into the Comment field. Add as many rules to the Rule list as
you would like to your filter using Add... button. If the filter has more
than one rule, select one of the Rule operations . This allows you to
choose whether all rules must apply, only one (either) rule must ap-
ply, or exactly one (either) rule must apply, in order for the filter to
generate a match. If your filter has only one rule, this selection has no
effect.

Check Return values that do not match the filter rules to invert
the filter rule. For example, inverting "has a common ancestor with I1"
rule will match everyone who does not have a common ancestor with
that person).

Clicking the Add... button invokes the following Add Rule dialog:

Fig.11.2 Add rule

The pane on the left-hand side displays available filter rules
arranged by their categories in an expandable tree. For detailed filter
rule reference. Click on the arrows to fold/unfold the appropriate cat-
egory. Select the rule from the tree by clicking on its name. The right-
hand side displays the name, the description, and the values for the
currently selected rule. Once you are satisfied with your rule selection
and its values, click OK to add this rule to the rule list of the currently
edited filter. Clicking Cancel will abort adding the rule to the filter.

Tip
A filter you have already designed may
be used as a rule for another filter. This
gives you nearly infinite flexibility in
custom-tailoring your selection criteria
that can be later used in most of the ex-
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ports, reports, and some of the tools
(such as comparing individual events).

Which filters in which view?
Depending on the used View, you will get a different set of filters.
• Gramplets

no filters available

• Persons View, Relationships View, and Pedigree View
Ancestral filters, Descendant filters, Family filters, General
filters, Event filters, and Relationship Filters.

• Events View, Sources View, Media view, Repositories View,
and Notes View

only General filters. Those General filters are specific for a
View: in the Media View the filters will only sort and search
on Media Objects.

• Places View
General filters, and Position filters.

General filters
Persons-, Relationship-, and Pedigree View
This category includes the following general rules:
• Bookmarked People

Matches the people on the bookmark list.

• Default person
Matches the default person.

• Disconnected People
Matches people that have no family relationships to any
other person in the database.

• Everyone
Matches everyone in the database.

• Females
Matches all females.

• Males
Matches all males.

• People having <count> notes
Matches people having a certain number of notes: Values:
Number of instances -- Number must be greater than/lesser/
equal to

• People having notes containing <regular expression>
Matches people whose notes contain text matching a regular
expression. Values: Regular expression

• People having notes containing <substring>
Matches people whose notes contain text matching a
substring. Values: Substring

• People marked private
Matches people that are indicated as private.

• People matching the <filter>
Matches people matched by the specied filter name. Values:
Filter name. The specified filter name should be selected
from the menu.
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• People probably alive
Matches people without indications of death that are not too
old. Values: On Date

• People with <id> matching regular expression
Matches people whose GRAMPS ID matches the regular
expression. Values: Regular expression

• People with <count> LDS events
Matches people with a certain number of LDS events.
Values: Number of instances -- Number must be greater
than/lesser/equal to

• People with <count> addresses
Matches people with a certain number of personal addresses.
Values: Number of instances -- Number must be greater
than/lesser/equal to

• People with <count> associations
Matches people with a certain number of associations.
Values: Number of instances -- Number must be greater
than/lesser/equal to

• People with <count> media
Matches people with a certain number of items in the gallery.
Values: Number of instances -- Number must be greater
than/lesser/equal to

• People with <count> source
Matches people with a certain number of items in the source.
Values: Number of instances -- Number must be greater
than/lesser/equal to

• People with <marker>
Matches people with a marker of a particular value. Values:
Marker type ’ ’, Complete, or ToDo.

• People with complete records
Matches all the people whose records are complete.

• People with incomplete names
Matches people with firstname or lastname missing.

• People with records containing <substring>
Matches people whose records contain text matching a
substring. Values: Substring -- Case Sensitive or not --
Regular-Expression matching or not

• People with the <name>
Matches people with a specied (partial) name. Values: Given
Name -- Family Name -- Suffix -- Title -- Prefix --
Patronymic -- Call Name

• People with the source
Matches people who have a particular source. values: Source
ID

• People with the family <attribute>
Matches people with the family attribute of a particular
value. Values: Family Attribute: Identification Number --
Age ...

• People with the personal <attribute>
Matches people with the personal attribute of a particular
value. Values: Family Attribute: Identification Number --
Age ...
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• People with unknown gender
Matches all people with unknown gender.

• People without a known birth date
Matches people without a known birthdate.

• People with <id>
Matches people with GRAMPS ID. The rule returns a match
only if the ID is matched exactly. You can either enter the ID
into a text entry field, or select an object from the list by
clicking Select... button. In the latter case, the ID will appear
in the text field after the selection was made.

• People changed after <date time>
Matches person records changed after a specified date-time
(yyy-mm-dd hh:mm:ss) or in the range, if a second date-time
is given: Values: Changed after: -- but before:.

• People with events matching the <event filter>
Matches persons who have events that match a certain event
filter. Values: Event filter name.

Person filters
• Has Address

This rule matches people with a personal address.

• Has Association
This rule matches people with a personal association.

• Has Complete Record
This rule matches all people whose records are marked as
complete. Currently, the completeness of personal
information is marked manually, in the Edit Person dialog.

• Has Name
This rule matches any person whose name matches the
specified value in full or in part. For example, Marta
Ericsdotter will be matched by the rule using the value "eric"
for the family name. Separate values can be used for Given
name, Family name, Suffix, and the Title. The rule returns a
match if, and only if, all non-empty values are (partially)
matched by a person’s name. To use just one value, leave the
other values empty.

• Is default person
This rule matches the default (home) person.

• Is a female
This rule matches any female person.

• Is a male
This rule matches any male person.

• People probably alive
This rule matches all people whose records do not indicate
their death and who are not unreasonably old, judging by
their available birth data and today’s date.

• People with incomplete names
This rule matches all people with either given name or
family name missing.

• People without a birth date
This rule matches people missing birth date.
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Event filters
This category includes the following rules that match people based on
their recorded events:
• Has the birth

This rule matches people whose birth event matches
specified values for Date, Place, and Description. The rule
returns a match even if the person’s birth event matches the
value partially. The matching rules are case-insensitive. For
example, anyone born in Sweden will be matched by the rule
using the value "sw" for the Place. The rule returns a match
if, and only if, all non-empty values are (partially) matched
by a person’s birth. To use just one value, leave the other
values empty.

• Has the death
This rule matches people whose death event matches
specified values for Date, Place, and Description. The rule
returns a match even if the person’s death event matches the
value partially. The matching rules are case-insensitive. For
example, anyone who died in Sweden will be matched by the
rule using the value "sw" for the Place. The rule returns a
match if, and only if, all non-empty values are (partially)
matched by a person’s death. To use just one value, leave the
other values empty.

• Has the personal event
This rule matches people that have a personal event
matching specified values for the Event type, Date, Place,
and Description. The rule returns a match even if the
person’s event matches the value partially. The matching
rules are case-insensitive. For example, anyone who
graduated in Sweden will be matched by the rule using the
Graduation event and the value "sw" for the Place. The

personal events should be selected from a pull-down menu.
The rule returns a match if, and only if, all non-empty values
are (partially) matched by the personal event. To use just one
value, leave the other values empty.

• Has the family event
This rule matches people that have a family event matching
specified values for the Event type, Date, Place, and
Description. The rule returns a match even if the person’s
event matches the value partially. The matching rules are
case-insensitive. For example, anyone who was married in
Sweden will be matched by the rule using the Marriage event
and the value "sw" for the Place. The family events should
be selected from a pull-down menu. The rule returns a match
if, and only if, all non-empty values are (partially) matched
by the personal event. To use just one value, leave the other
values empty.

• Witness
This rule matches people who are present as a witness in the
event. If the personal or family event type is specified, only
the events of this type will be searched.

• People with incomplete events
This rule matches people missing date or place in any
personal event.

• Families with incomplete events
This rule matches people missing date or place in any family
event of any of their families.
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Family filters
This category includes the following rules that match people based on
their family relationships:
• People with children

This rule matches people with children.

• People with multiple marriage records
This rule matches people with more than one spouse.

• People with no marriage records
This rule matches people with no spouses.

• People who were adopted
This rule matches adopted people.

• Has the relationships
This rule matches people with a particular relationship. The
relationship must match the type selected from the menu.
Optionally, the number of relationships and the number of
children can be specified. The rule returns a match if, and
only if, all non-empty values are (partially) matched by a
person’s relationship. To use just one value, leave the other
values empty.

• Is spouse of filter match
This rule matches people married to someone who is
matched by the specified filter. The specified filter name
should be selected from the menu.

• Is a child of filter match
This rule matches people for whom either parent is matched
by the specified filter. The specified filter name should be
selected from the menu.

• Is a parent of filter match
This rule matches people whose child is matched by the
specified filter. The specified filter name should be selected
from the menu.

• Is a sibling of filter match
This rule matches people whose sibling is matched by the
specified filter. The specified filter name should be selected
from the menu.

Ancestral filters
This category includes the following rules that match people based on
their ancestral relations to other people:
• Is an ancestor of

This rule matches people who are ancestors of the specified
person. The Inclusive option determines whether the
specified person should be considered his/her own ancestor
(useful for building reports). You can either enter the ID into
a text entry field, or select a person from the list by clicking
Select... button. In the latter case, the ID will appear in the
text field after the selection was made.

• Is an ancestor of person at least N generations away
This rule matches people who are ancestors of the specified
person and are at least N generations away from that person
in their lineage. For example, using this rule with the value
of 2 for the number of generations will match grandparents,
great-grandparents, etc., but not the parents of the specified
person.

• Is an ancestor of person not more than N generations away
This rule matches people who are ancestors of the specified
person and are no more than N generations away from that
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person in their lineage. For example, using this rule with the
value of 2 for the number of generations will match parents
and grandparents, but not great-grandparents, etc., of the
specified person.

• Has a common ancestor with
This rule matches people who have common ancestors with
the specified person.

• Has a common ancestor with filter match
This rule matches people who have common ancestors with
someone who is matched by the specified filter. The
specified filter name should be selected from the menu.

• Is an ancestor of filter match
This rule matches people who are ancestors of someone who
is matched by the specified filter. The specified filter name
should be selected from the menu.

Descendant filters
This category includes the following rules that match people based on
their descendant relations to other people:
• Is a descendant of

This rule matches people who are descendants of the
specified person. The Inclusive option determines whether
the specified person should be considered his/her own
descendant (useful for building reports). You can either enter
the ID into a text entry field, or select a person from the list
by clicking Select... button. In the latter case, the ID will
appear in the text field after the selection was made.

• Is a descendant of person at least N generations away
This rule matches people who are descendants of the
specified person and are at least N generations away from
that person in their lineage. For example, using this rule with
the value of 2 for the number of generations will match
grandchildren, great-grandchildren, etc., but not the children
of the specified person.

• Is a descendant of person not more than N generations away
This rule matches people who are descendants of the
specified person and are no more than N generations away
from that person in their lineage. For example, using this rule
with the value of 2 for the number of generations will match
children and grandchildren, but not great-grandchildren, etc.,
of the specified person.

• Is a descendant of filter match
This rule matches people who are descendants of someone
who is matched by the specified filter. The specified filter
name should be selected from the menu.

• Is a descendant family member of
This rule not only matches people who are descendants of
the specified person, but also those descendants’ spouses.

Relationship filters
This category includes the following rules that match people based on
their mutual relationship:
• Relationship path between two people

This rule matches all ancestors of both people back to their
common ancestors (if exist). This produces the "relationship
path" between these two people, through their common
ancestors. You can either enter the ID of each person into the
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appropriate text entry fields, or select people from the list by
clicking their Select... buttons. In the latter case, the ID will
appear in the text field after the selection was made.

Miscellaneous filters
This category includes the following rules which do not naturally fit
into any of the above categories:
• Has the personal attribute

This rule matches people who have the personal attribute of
the specified value. The specified personal attribute name
should be selected from the menu. The specified value
should be typed into the text entry field.

• Has the family attribute
This rule matches people who have the family attribute of the
specified value. The specified family attribute should be
selected from the menu. The specified value should be typed
into the text entry field.

• Has LDS
This rule matches people or families with a LDS event.

Previous Index Next
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Gramps 3.3 Wiki Manual - FAQ

This appendix contains the list of questions that frequently come up in
mailing list discussions and forums. This list is by no means complete.
If you would like to add questions/answers to this list, please email
your suggestions to the gramps-devel@lists.sourceforge.net list.

Special copyright notice: All edits to this page need to be
under two different copyright licenses:
• GNU Free Documentation License 1.2 - see wiki

copyright
• GPL - see manual copyright

These licenses allow the Gramps project to maximally use
this wiki manual as free content in future Gramps versions.
If you do not agree with this dual license, then do not edit
this page. You may only link to other pages within the wi-
ki which fall only under the GFDL license via external
links (using the syntax: [http://www.gramps-project.org/
...]), not via internal links.
Also, only use the known conventions

Previous Index Next

Also consider having a look at:
• How do I...
• GRAMPS Tutorials

General
What is GRAMPS?
GRAMPS is the Genealogical Research and Analysis Management
Program System. In other words, it is a personal genealogy program
letting you store, edit, and research genealogical data using the powers
of your computer, see About.

Where do I get it and how much does it cost?
GRAMPS can be installed at no charge. GRAMPS is an Open Source
project covered by the GNU General Public License. You have full ac-
cess to the source code and are allowed to distribute the program and
source code freely.

Does GRAMPS exist in other languages?
Yes, at the moment GRAMPS is translated in 23 languages, see
GRAMPS translations.

How do I keep backups?
Use a recent version of GRAMPS! From 2.2.5 onwards there is an au-
tomatic backup utility.

It is extremely important to keep backups of your data, and keep
them in a safe place. GRAMPS has a specific portable file format
which is small, and human readable, denoted by .gramps.

You can copy this backup file from time to time to a save location
(eg a usb stick). [Note: The .gramps files are compressed. Clicking
them will open GRAMPS. To see the XML select them and open them
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with a decompressing utility (like ark, gunzip), after which you can
extract the XML file which is human readable, see details.

GRAMPS does a quick hidden binary backup to allow restore if an
error is noted. If the correct package is installed you can use a revision
system.

Another method is to backup the hidden directory /.gramps. This
directory is situated in your home directory on Linux systems. Back-
ing up this directory will backup your databases and revisions.

Do not keep backups in GEDCOM. Not all information
GRAMPS stores can be written in the GEDCOM. Hence, an export/
import operation GRAMPS --> GEDCOM --> GRAMPS, will mean
you lose data. Use the .gramps file format for backups!

Do not keep backups in GRDB format. GRDB is a database,
which might be computer dependent (read, not working on a different
PC). Small damage to a GRDB file can also not be repaired. Use the
.gramps file format for backups!

Does Gramps support Unicode fonts?
In particular, does it support non-Roman Unicode fonts? Yes.
GRAMPS works internally with Unicode (UTF-8), so all alphabets
can be used on all entry fields. All reports fully support this, although
for PDF/PS you need to work with gnome-print or LibreOffice.

Installation
What is needed to install GRAMPS under Linux, Solaris,
or FreeBSD?
GRAMPS is a GTK application. GRAMPS needs to have the pygtk li-
braries installed on the system. As long as these libraries are installed,
GRAMPS should function. It will operate under the GNOME desk-
top, KDE desktop, or any other desktop. If the GNOME bindings for
Python are installed on the system, GRAMPS will have additional

functionality. The GRAMPS project recommends version 2.8 or high-
er of GTK.

Does GRAMPS work on Windows?
Yes, many people use it on Windows. Probably the easiest thing is to
Download the GrampsAIO software "bundle" for Windows, as that is
an all-in-one package of GRAMPS with the other programs it needs,
and so may be installed very trivially.

We will do our best to solve Windows-related problems. See here.
See GRAMPS and Windows for a summary of hints to use

GRAMPS on a Windows PC.
Also, the Linux Genealogy CD can function as a live CD that you

boot directly from. You can then run Linux and GRAMPS off the CD,
even if your computer is entirely Windows.

A Windows installer is available, for the technically sophisticated.

Does GRAMPS work on the Mac?
Yes, Mac is a supported platform for GRAMPS. See here.

What are the Minimum Specs to run GRAMPS?
We would recommend at least an 800x600 video display. For
GRAMPS 3.3, the memory requirements have been reduced, and
GRAMPS can run quite efficiently on a 256MB system, holding con-
siderably more people. A system with 512MB should be able to hold
around 200,000 people. Disk space requirements for databases are
however considerably larger, with a typical database being several
megabytes in size. For 120.000 people you must consider already
530Mb for the database. Pictures are stored on disk separately, so a
large harddisk is necessary.
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How do I upgrade GRAMPS?
GNU/Linux operating systems will typically deal with upgrade issues
for you. If they do not then you need to ask users of your prefered
GNU/Linux distribution.

The Windows port of GRAMPS needs to be updated manually.
(incomplete answer)

Preferences
Can I change the dates in reports to ’day month year’?
Yes, change in the preferences ("Edit->Preferences") the date for
GRAMPS to the required format (eg YYYY-MM-DD or day month
year), and make the report. Your global date preferences will be used.

Collaboration-Portability
Is GRAMPS compatible with other genealogical software?
GRAMPS makes every effort to maintain compatibility with
GEDCOM, the general standard of recording genealogical informa-
tion. We have import and export filters that enable GRAMPS to read
and write GEDCOM files.

It is important to understand that the GEDCOM standard is poorly
implemented -- virtually every genealogical software has its own "fla-
vor" of GEDCOM. As we learn about new flavor, the import/export
filters can be created very quickly. However, finding out about the un-
known flavors requires user feedback. Please feel free to inform us
about any GEDCOM flavor not supported by GRAMPS, and we will
do our best to support it!

Can GRAMPS read files created by other genealogy pro-
grams?
See above.

Can GRAMPS write files readable by other genealogy pro-
grams?
See above.

What standards does GRAMPS support?
The nice thing about standards is that there never is a shortage of them.
GRAMPS is tested to support the following flavors of GEDCOM:
GEDCOM5.5, Brother’s Keeper, Family Origins, Family Tree Maker,
Ftree, GeneWeb, Legacy, Personal Ancestral File, Pro-Gen, Reunion,
and Visual Genealogie.

How do I import data from another genealogy program into
GRAMPS?
The best way is to create a new family tree, and select the import op-
tion in the file menu. Here you select the GEDCOM you generated
with the other program, and import it.

Can I install GRAMPS on a Linux Web Server and use it
via a web browser?
This would enable my relations worldwide to access and update it.
While GRAMPS can generate web sites, it does not provide a web in-
terface that allows for editing. If this is a requirement, then GeneWeb
or PhpGedView are programs more likely to meet your needs. Also
have a look at experimental gramps-connect. However, you may wish
to ask yourself the following questions:
1. Do I really want relatives or other people to directly edit my

genealogy database?
2. Do I implicitly trust, without verification, any data that people

may enter?
3. Do these people have the same understanding of good genealogy

practice that I have?
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A better approach may be to provide a web form interface that allows
others to enter data that is then held for your examination. You can
then decide if the information should be entered into your database.

You may also want to consider the effects of possible downtime of
your site if you cannot afford yourself a premium webhosting service.

Reports
Can GRAMPS print a genealogical tree for my family?
Yes. Different people have different ideas of what a genealogical tree
is. Some think of it as a chart going from the distant ancestor and list-
ing all his/her descendants and their families. Others think it should be
a chart going from the person back in time, listing the ancestors and
their families. Yet other people think of a table, text report, etc.

GRAMPS can produce any of the above, and many more different
charts and reports. Moreover, the plugin architecture enables users
(you) to create their own plugins which could be new reports, charts,
or research tools.

In what formats can GRAMPS output its reports?
Text reports are available in HTML, PDF, ODT, LaTeX, and RTF
formats. Graphical reports (charts and diagrams) are available in
PostScript, PDF, SVG, ODS, and GraphViz formats.

How can I change the default language in reports?
The reports are in the language of your linux installation. You can
change it by installing extra language packs, see Howto: Change the
language of reports

Is GRAMPS compatible with the Internet?
GRAMPS can store web addresses and direct your browser to them. It
can import data that you download from the Internet. It can export da-

ta that you could send over the Internet. GRAMPS is familiar with the
standard file formats widely used on the Internet (e.g. JPEG, PNG, and
GIF images, MP3, OGG, and WAV sound files, QuickTime, MPEG,
and AVI movie files, etc). Other than that, there is little that a ge-
nealogical program can do with the Internet.

Can I create custom reports/filters/whatever?
Yes. There are many levels of customization. One is creating or mod-
ifying the templates used for the reports. This gives you some control
over the fonts, colors, and some layout of the reports. You can also use
GRAMPS controls in the report dialogs to tell what contents should
be used for a particular report. In addition to this, you have an ability
to create your own filters -- this is useful in selecting people based on
criteria set by you. You can combine these filters to create new, more
complex filters. Finally, you have an option to create your own plu-
gins. These may be new reports, research tools, import/export filters,
etc. This assumes some knowledge of programming in Python.

Why are non-Latin characters displayed as garbage in PDF/
PS reports?
This is a limitation of the built-in fonts of PS and PDF formats. To
print non-Latin text, use the Print... in the format selection menu of
the report dialog. This will use the gnome-print backend, which
supports PS and PDF creation, as well as direct printing. (Note: you
might need to install gnome-print separately as it is not required for
GRAMPS).

If you only have Latin text, the PDF option will produce a smaller
PDF compared to that created by gnome-print, simply because no font
information will be embedded.
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I would like to contribute to GRAMPS by writing my fa-
vorite report. How do I do that?
The easiest way to contribute to reports, filters, tools, etc. is to copy
an existing GRAMPS report, filter, or tool. If you can create what
you want by modifying existing code -- great! If your idea does not
fit into the logic of any existing GRAMPS tool, you will need to
write your own plugin from scratch. Help is available on the Devel-
opers Portal, or on the Developers mailing list: gramps-dev-
el@lists.sourceforge.net.

To test your work in progress, you may save your plugin under
$HOME/.gramps/plugins directory and it should be found and import-
ed on startup. The correctly written plugin will register itself with
GRAMPS, create menu item, and so on.

If you are happy with your plugin and would like to contribute
your code back to the GRAMPS project, you are very welcome to do
so by contacting us at gramps-devel@lists.sourceforge.net

Database - GRAMPS file formats
What is the maximum database size (bytes) GRAMPS can
handle?
GRAMPS has no hard limits on the size of a database that it can han-
dle. Starting with 2.0.0 release, GRAMPS no longer loads all data in-
to memory, which allows it to work with a much larger database than
before. In reality, however, there are practical limits. The main limit-
ing factors are the available memory on the system and the cache size
used for BSDDB database access. With common memory sizes these
days, GRAMPS should have no problem using databases with tens of
thousands of people.

How many people can GRAMPS database handle?
See above. Again, this is dependent on how much memory you have,
see GRAMPS Performance.

My database is really big. Is there a way around loading all
the data into memory?
Starting with 2.0.0 release, GRAMPS no longer loads all data into
memory, which allows it to work with a much larger database than be-
fore. The fileformat used is .grdb which means gramps database.

Can I run GRAMPS from a database on a NFS share?
Yes you can.

What does "portable" mean?
A GRAMPS 3 database (and any .grdb file) is very dependent on the
software versions that created it. For example, you can’t just move
your GRAMPS data in these formats to a different operating system
(or even a different version of an operating system) and expect that
you will be able to read your data. The data is not "portable". There-
fore, you can’t just rely on backups of these formats, but you should
also occasionally export into a format that is portable. There are two
possible portable formats: GEDCOM and GRAMPS XML (.gramps
or .gpkg). But only GRAMPS XML is recommended, as it faithfully
saves all of your data.

Why is the database format (GRDB) not portable?
The biggest issue with GRAMPS portability lies with ’transactions’.
With GRAMPS 2.2, we added support for atomic transactions to pro-
tect data. With atomic transactions, multiple changes are committed as
a single unit. Either all the changes make it, or none of the changes
make it. You are never left in a situation with a partial set of changes.
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A side benefit of using transactions is that database access (reads and
writes) are faster.

The problem with transactions (at least using BSDDB) is that it
does not allow all the data to be stored in a single file. Logging files
are needed to keep track of things. These logging files are kept in a
DB Environment directory. We need a separate directory for each file,
otherwise the log files can interfere with each other.

In 2.2, we keep the log files under the ~/.gramps/<path> directory,
creating a unique directory for each database. The problem is that
your GRDB file needs the log files, which are in a different directory.
Copying the GRDB file is only copying a portion of the database.

Bugs and requests
What do I do if I have found a bug?
The best thing you can do is to fix the bug and send the patch to
gramps-devel@lists.sourceforge.net :-)

If that is not possible, you should submit a bug report
A good bug report would include:

1. Version of gramps you were using when you encountered the bug
(available through Help → About menu item).

2. Language under which gramps was run (available by executing
echo $LANG in your terminal).

3. Symptoms indicating that this is indeed a bug.
4. Any Traceback messages, error messages, warnings, etc, that

showed up in your terminal or a in separate traceback window.
Most problems can be fixed quickly provided there is enough infor-
mation. To ensure this, please follow up on your bug reports. Then we
will have a way of contacting you should we need more information.

Requests
• GRAMPS should be a .... type of application

It is obvious that GRAMPS absolutely needs to become a (client-serv-
er/web-based/PHP/weblog/Javascript/C++/distributed/KDE/Motif/
Tcl/Win32/C#/You-name-it) application. When is this going to hap-
pen?

The surest way to see it happen is to get it done by yourself. Since
GRAMPS is free/open source, nobody prevents you from taking all
of the code and continuing its development in whatever direction you
see fit. In doing so, you may consider giving your new project another
name to avoid confusion with the continuing GRAMPS development.
If you would like the GRAMPS project to provide advice, expertise,
filters, etc., we will gladly cooperate with your new project, to ensure
compatibility or import/export options to your new format of a project.

If, however, you would like the GRAMPS project to adopt your
strategy, you would need to convince GRAMPS developers that your
strategy is good for GRAMPS and superior to the present development
strategy.

Adding to and editing my database
What is the difference between a residence and an address?
A residence is a place where someone lived for a period of time. An
address is the name of a residence formatted in the way expected by
the postal system. Therefore each residence can also have an address
if that is useful.

How do I change the order of children?
Children can be moved in the Family Editor by dragging and dropping
or using the up and down buttons.

How do I change the order of spouses?
Spouses can be reordered from the Relationship View by selecting the
Reorder button in the toolbar.
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Gramps 3.3 Wiki Manual - Keybindings

This appendix lists keybindings you can use on the GRAMPS dialogs,
so as to avoid the use of the mouse.

Special copyright notice: All edits to this page need to be
under two different copyright licenses:
• GNU Free Documentation License 1.2 - see wiki

copyright
• GPL - see manual copyright

These licenses allow the Gramps project to maximally use
this wiki manual as free content in future Gramps versions.
If you do not agree with this dual license, then do not edit
this page. You may only link to other pages within the wi-
ki which fall only under the GFDL license via external
links (using the syntax: [http://www.gramps-project.org/
...]), not via internal links.
Also, only use the known conventions

Previous Index Next

List Views
Common bindings
The following bindings are available in all views.

Key Function
<CTRL>N Changes the view to the next view category
<CTRL>P Changes the view to the previous view cate-

gory
<CTRL>M Close the navigator panel (left sidebar)
<CTRL>1/2/... Changes the view to view number 1/2/... in

this view category
<CTRL>B Open the Clipboard
<Ctrl>D Add the selected item as a bookmark
<Shift><Ctrl>D Organize the bookmarks
<Ctrl>H Open the Undo History dialog
<Ctrl>J Jump to an ID
<ALT>Left arrow Move to previous item in history
<ALT>Right ar-
row

Move to next item in history

<Shift><CTRL>C Configure active view
<Shift><CTRL>R Toggle the right gramplet sidebar
<Shift><CTRL>B Toggle the bottom gramplet sidebar

All List Views bindings
The following bindings are available in all list views: People, Family
List, Events, Sources, Places, Media, Repositories and Notes View.

Key Function
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Enter Edits the selected list item
<Ctrl>Insert Adds a new item to the database
<Ctrl>Delete Deletes the selected list item

People View bindings

Key Function
Enter Expands and hides entries of the selected surname

Editor Tab bindings
These bindings work on the tab pages of the editors (so not on the la-
bels of the tabs!, press tab on label to move to tabpage content).

Key Function
Enter Same action as the Edit button when that button

is present
Insert Same action as the Add button when that button

is present
Delete Same action as the Remove button when that

button is present
CTRL+O Same action as the Share button when that but-

ton is present
ALT+Left ar-
row

Change tabpage to the tabpage to the left

ALT+Right
arrow

Change tabpage to the tabpage to the right

Mouse
Key

Function

Right-
click

Call up context popup

Double-
click

Same action as the Edit button when that button is pre-
sent

Middle-
click

Common action that is not the same as Edit button.
Eg: on Family Editor Child tab, edit child

Previous Index Next
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Gramps 3.3 Wiki Manual - Command Line

This appendix provides the reference to the command line capabilities
available when launching GRAMPS from the terminal.

Special copyright notice: All edits to this page need to be
under two different copyright licenses:
• GNU Free Documentation License 1.2 - see wiki

copyright
• GPL - see manual copyright

These licenses allow the Gramps project to maximally use
this wiki manual as free content in future Gramps versions.
If you do not agree with this dual license, then do not edit
this page. You may only link to other pages within the wi-
ki which fall only under the GFDL license via external
links (using the syntax: [http://www.gramps-project.org/
...]), not via internal links.
Also, only use the known conventions
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Available options
This section provides the reference list of all command line options
available in GRAMPS. If you want to know more than just a list of op-
tions, see next sections: Operation and Examples. A list is also avail-
able on this page.

List options

-l, print a list of known family trees
-L, print a detailed list of known family trees

Version options

-v or --version prints version of Gramps and dependencies,
information about environment settings and python and system paths

Format options
The format of any file destined for opening, importing, or exporting
can be specified with the

-f format

option. The acceptable format values are listed below.

Full family tree support
These formats contain all your data that is present in a family tree.
• - GRAMPS XML format: This format is available for import, and

export. When not specified, it can be guessed if the filename ends
with .gramps

• - GRAMPS package XML format: This format is available for
import and export. When not specified, it can be guessed if the
filename ends with .gpkg. This creates a zip package with your
data as xml, and all your media files included
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• - pre GRAMPS 3.x database: This format is available for import
to support the old file format of GRAMPS. Everything in the
grdb file is imported. When not specified, it can be guessed if the
filename ends with .grdb

• - GNOME iso burning: export, only available on GNOME where
burn protocol exists

Reduced family tree support
These formats contain most, but not all data that can be created in
GRAMPS
• - GEDCOM format: This format is available for import, and

export. When not specified, it can be guessed if the filename ends
with .ged

• - GeneWeb file: This format is available for import and export.
When not specified, it can be guessed if the filename ends with
.gw

Subset of your data
These formats contain a specific subset of your data
• - Comma Separated Value: This format is available for import

and export. Be careful however, import must be as values created
by the export function. Only a part of your data is contained in
the output.

• - VCard format: import and export
• - VCalandar format: export
• - old Pro-Gen format: import
• - Web Family Tree: This format is available for export only.

When not specified, it can be guessed if the filename ends with
.wft

Opening options
You can open a family tree, or you can open a file by importing it in
an empty family tree. To let GRAMPS handle this automatically, just
supply the familytree or filename you want to open:

python gramps.py ’My Fam Tree’
python gramps.py JohnDoe.ged

The first opens a family tree, the second imports a gedcom into an
empty family tree.

Additionally, you can pass GRAMPS the name of the family tree
to be opened:
• use this option :

-O famtree

or

--open=famtree

-O, Open of a family tree. This can be done also by just typing the
name (name or database dir)

Examples:

python gramps.py ’Family Tree 1’
python gramps.py /home/cristina/.gramps/grampsdb/47320f3d
python gramps.py -O ’Family Tree 1’
python gramps.py -O /home/cristina/.gramps/grampsdb/47320f3d
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Tip
If no option is given, just a name,
GRAMPS will ignore the rest of the
command line arguments. Use the -O
flag to open, -i to import, and do some-
thing with the data.

Tip
Only family trees can be opened direct-
ly. For other formats, you will need to
use the import option which will set up
the empty database and then import data
into it.

Tip
Only a single family tree can be opened.
If you need to combine data from sever-
al sources, you will need to use the im-
port option.

Import options
The files destined for import can be specified with the

-i filename

or

--import=filename

option. The format can be specified with the

-f format

or

--format=format

option, immediately following the filename . If not specified, the guess
will be attempted based on the filename.
Example:

python gramps.py -i ’Family Tree 1’ -i ’Family Tree 2’
python gramps.py -i test.grdb -i data.gramps

Tip
More than one file can be imported in
one command. If this is the case,
GRAMPS will incorporate the data from
the next file into the database available
at the moment.

When more than one input file is given, each has to be preceded by

-i

flag. The files are imported in the specified order, i.e.

-i file1 -i file2

and

-i file2 -i file1

might produce different GRAMPS IDs in the resulting database.
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Export options
The files destined for export can be specified with the

-e filename

or

--export=filename

option. The format can be specified with the

-f

option immediately following the filename . If not specified, the guess
will be attempted based on the filename . For iso format, the filename
is actually the name of directory the GRAMPS database will be writ-
ten into. For gramps-xml, gpkg, gedcom, wft, geneweb, and gramps-
pkg, the filename is the name of the resulting file.
-e, export a family tree in required format. It is not possible to export
to a family tree.

Example:

python gramps.py -i ’Family Tree 1’ -i test.grdb -f grdb -e mergedDB.gramps

Note that above does not change ’Family Tree 1’ as everything hap-
pens via a temporary database, whereas:

python gramps.py -O ’Family Tree 1’ -i test.grdb -f grdb -e mergedDB.gramps

will import test.grdb into Family Tree 1, and then export to a file !

Exporting more files
More than one file can be exported in
one command. If this is the case,
GRAMPS will attempt to write several
files using the data from the database
available at the moment.

When more than one output file is given, each has to be preceded by

-e

flag. The files are written one by one, in the specified order.

Action options
The action to perform on the imported data can be specified with the

-a action

or

--action=action

option. This is done after all imports are successfully completed.
The following actions remain the same:
• report: This action allows producing reports from the command

line.
• tool: This action allows to run a tool from the command line.

Reports and tools generally have many options of their own, so these
actions should be followed by the report/tool option string. The string
is given using the

-p option_string
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or

--options=option_string

option.
The actions available in older versions of Gramps which were relocat-
ed in Gramps 3.3 are:
• summary: This action was the same as Reports ->View -

>Summary . In Gramps 3.3 it was replaced by (or renamed to) -a
report -p name=summary.

• check: This action was the same as Tools ->Database Processing
->Check and Repair . In Gramps 3.3 it was replaced by (or
renamed to) -a tool -p name=check.

report action option
You can generate most reports from the command line using the report
action. An example:

gramps -O "Family Tree 1" -a report -p "name=family_group,style=default,off=html,of=test.html"

In version 3.3, you can provide the css style to use here with the css
option:

gramps -O "Family Tree 1" -a report -p "name=family_group,style=default,off=html,of=test.html,css=Web_Nebraska.css"

or without css in the html output:

gramps -O "Family Tree 1" -a report -p "name=family_group,style=default,off=html,of=test.html,css="

Report option string
The report option string should satisfy
the following conditions: It must not
contain any spaces (due to the general

nature of the command line interface). If
some arguments need to include spaces,
the string should be enclosed with quo-
tation marks. Option string must list
pairs of option names and values.
Within a pair, option name and value
must be separated by the equal sign.
Different pairs must be separated by
commas.

Most of the report options are specific for every report. However,
there are some common options.
• name=report_name: This mandatory option determines which

report will be generated. If the supplied report_name does not
correspond to any available report, an error message will be
printed followed by the list of available reports.

• of : output filename
• off: output format. These are the extension an output format

makes available, eg, pdf, html, doc, ...
• style: for text reports, the stylesheet to use. Defaults to ’default’.
• show=all: This will produce the list of names for all options

available for a given report.
• show=option_name: This will print the description of the

functionality supplied by the option_name, as well as what are the
acceptable types and values for this option.

So, to learn to use a report, do for example:

gramps -O "Family Tree 1" -a report -p "name=family_group,show=all"
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Tip
If an option is not supplied, the last used
value will be used. If this report has
never been generated before, then the
value from last generated report will be
used when applicable. Otherwise, the
default value will be used.

When more than one output action is given, each has to be preceded
by

-a

flag. The actions are performed one by one, in the specified order.

lists
Some reports have options or arguments
which are interpreted (by the report) to
be on multiple lines. For instance some
reports allow you to format how the in-
formation will be shown, perhaps with a
name on one line and the person’s birth
date on the next line. Such multiple-line
options or arguments are called "lists"
by GRAMPS.

On the command line such lists must always start with a left square
bracket

[

and must always end with a right square bracket

]

but since such square brackets are usually "special" to the "shell" (they
mean something to the command interpreter you are typing the com-
mand to), you must "escape" them so that they are ignored by your
shell. The details vary with each shell but (in linux/UNIX) usually you
can precede such a square bracket with a backslash

\

or put quotation marks around the square bracket, usually either "sin-
gle" or "double" ones.

The Hourglass Graph report allows you to put a "note" at the top
of the report and such a "note" is an example of a "list" option. Here is
an example:

gramps -O "Family Tree 1" -a report -p name=hourglass_graph,note=’[line one,line two]’

which shows that inside such a list different lines are separated by
commas, and that spaces are acceptable since the quotation marks are
already there for the square brackets.

But if you want to have a comma inside your report you have to
somehow tell GRAMPS that comma is not one which separates lines.
You do that by enclosing the line with the comma in quotation marks
(either single or double). But if you are already using a set of quota-
tion marks (to enclose your square brackets) you have to use the other
type to enclose the line with your comma. Here is an example:

gramps -O "Family Tree 1" -a report -p name=hourglass_graph,note="[’line one, also line one’,’line two, also line two’]"

It is possible to include any character in a list but the details are be-
yond the scope of this command-line introduction to GRAMPS. You
will need to know the precise methods available in your particular
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command shell interpreter to include a character which is "special" to
your shell or "special" to GRAMPS (like the comma in the example
above) but in general you will have to "escape" it twice, once to your
shell and once again to GRAMPS, since you don’t want your shell to
think it is some instruction it should pay attention to and you don’t
want GRAMPS to think that either.

tool action option
You can run most tools from the command line using the ’tool’ action.
To see which ones, say:

gramps -O "Family Tree 1" -a tool -p show=all

To see a tool’s available options, for instance the "verify" tool:

gramps -O "Family Tree 1" -a tool -p name=verify,show=all

To run a tool, for instance the "verify" tool:

gramps -O "Family Tree 1" -a tool -p name=verify

Force unlock option
-u, you can extend the -O flag with -u to force a locked family to be
unlocked. This allows you to recover from a crash that leaves the fam-
ily tree (database) locked, from the command line.

An example (to unlock the "Family Tree 1" database):

gramps -O "Family Tree 1" -a report -u > /dev/null

Note that it is not possible to open family trees that need repair from
the command line

Configuration (config) option
The option takes three forms: (the following examples, except 3.2, use
behavior.database-path as the configuration variable to change.)

1) See all config values

-s or --show

2) See a value:

--config=behavior.database-path
or
-c behavior.database-path

3) Set a value:

--config=behavior.database-path:’/media/mydb’
or
-c behavior.database-path:’/media/mydb’

3.1) Set a value to its default:

--config=behavior.database-path:DEFAULT
or
-c behavior.database-path:DEFAULT

3.2) Set more than one value:

--config=behavior.use-tips:False --config=behavior.autoload:True
or
-c behavior.use-tips:False -c behavior.autoload:True

When all configuration variable(s) are set Gramps will start with these
new values.
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Operation
If the first argument on the command line does not start with a dash
(i.e. no flag), GRAMPS will attempt to open the file with the name
given by the first argument and start an interactive session, ignoring
the rest of the command line arguments.
If the

-O

flag is given, then GRAMPS will try opening the supplied file name
and then work with that data, as instructed by the further command
line parameters.

Note
Only one file can be opened in a single
invocation of GRAMPS. If you need to
get data from multiple sources, use the
importing options by using

-i

flag.

With or without the

-O

flag, there could be multiple imports, exports, and actions specified
further on the command line by using

-i

,

-e

, and

-a

flags. The order of

-i

,

-e

, or

-a

options with respect to each does not matter. The actual execution or-
der always is: all imports (if any) -> all exports (if any) -> all actions
(if any).

Note
But opening must always be first!

If no

-O

or
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-i

option is given, GRAMPS will launch its main window and start the
usual interactive session with the empty database, since there is no da-
ta to process, anyway. (Unless you have already expressed a "prefer-
ence" that it start with the last database it used.) If no

-e

or

-a

options are given, GRAMPS will launch its main window and start the
usual interactive session with the database resulted from opening and
all imports (if any). This database resides in the import_db.grdb file
under the ~/.gramps/import/ directory.
Any errors encountered during import, export, or action, will be either
dumped to stdout (if these are exceptions handled by GRAMPS) or to
stderr (if these are not handled). Use usual shell redirections of stdout
and stderr to save messages and errors in files.

Examples
• To import four databases (whose formats can be determined from

their names) and then check the resulting database for errors, one
may type:

gramps -i file1.ged -i file2.gpkg -i ~/db3.gramps -i file4.wft -a check

• To explicitly specify the formats in the above example, append
filenames with appropriate -f options:

gramps -i file1.ged -f gedcom -i file2.gpkg -f gramps-pkg -i ~/db3.gramps -f gramps-xml -i file4.wft -f wft -a check

• To record the database resulting from all imports, supply -e flag
(use -f if the filename does not allow GRAMPS to guess the
format):

gramps -i file1.ged -i file2.gpkg -e ~/new-package -f gramps-pkg

• To save any error messages of the above example into files
outfile and errfile, run:

gramps -i file1.ged -i file2.dpkg -e ~/new-package -f gramps-pkg >outfile 2>errfile

• To import three databases and start interactive GRAMPS session
with the result:

gramps -i file1.ged -i file2.gpkg -i ~/db3.gramps

• To open a database and, based on that data, generate timeline
report in PDF format putting the output into the my_timeline.pdf
file:

gramps -O ’Family Tree 1’ -a report -p name=timeline,off=pdf,of=my_timeline.pdf

Listing report options
Use the name=time-
line,show=all to find out about all
available options for the timeline report.
To find out details of a particular option,
use show=option_name , e.g.
name=timeline,show=off string.
To learn about available report names,
use name=show string.

• To convert a grdb on the fly to a .gramps xml file:
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gramps -O ’Family Tree 1’ -e output.gramps -f gramps-xml

• To generate a web site into an other locale (in german):

LANGUAGE=de_DE; LANG=de_DE.UTF-8 gramps -O ’Family Tree 1’ -a report -p name=navwebpage,target=/../de

• Finally, to start normal interactive session type:

gramps

Environment variables
GRAMPS can take advantage of these environment variables (but do
not change them if you do not know what are you doing):
• - if set, override default path to profile allowing user to use ex.

network drive to store data and all settings.
• - is used by GRAMPS to determine which language file should be

loaded.

Previous Index Next
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Gramps 3.3 Wiki Manual - About

Special copyright notice: All edits to this page need to be
under two different copyright licenses:
• GNU Free Documentation License 1.2 - see wiki

copyright
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ki which fall only under the GFDL license via external
links (using the syntax: [http://www.gramps-project.org/
...]), not via internal links.
Also, only use the known conventions
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About
GRAMPS was written by Donald N. Allingham (don@gramps-pro-
ject.org).

The somewhat incomplete list of contributors includes (in alpha-
betical order):
• Alexander Bogdashevsky
• Alexander Roitman
• Alexandre Duret-Lutz
• Alexandre Prokoudine

• Anton Huber
• Arkadiusz Lipiec
• Arpad Horvath
• Arturas Sleinius
• Baruch Even
• Benny Malengier
• Bernd Felsche
• Bernd Schandl
• Billy C. Earney
• Brian Matherly
• Bruce J. DeGrasse
• Daniel Durand
• David R. Hampton
• Donald A. Peterson
• Douglas S. Blank
• Eero Tamminen
• Egyeki Gergely
• Frederick Noronha
• Frode Jemtland
• Gary Burton
• Gary Shao
• Greg Kuperberg
• Guillaume Pratte
• James Treacy
• Jason Salaz
• Jeffrey C. Ollie
• Jens Arvidsson
• Jérôme Rapinat
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• Jesper Zedlitz
• Jim Smart
• Jiri Pejchal
• Julio Sanchez
• Kees Bakker
• Larry Allingham
• Lars Kr. Lundin
• Laurent Protois
• Leonid Mamtchenkov
• Lorenzo Cappelletti
• Lubo Vasko
• Luiz Gonzaga dos Santos Filho
• Marcos Bedinelli
• Mark Knoop
• Martin Hawlisch
• Martin Senftleben
• Matt Brubeck
• Matthieu Pupat
• Michel Guitel
• Nathan Bullock
• Pier Luigi Cinquantini
• Radek Malcic
• Radu Bogdan Mare
• Richard Bos
• Richard Taylor
• Samuel Tardieu
• Sebastian Voecking
• Serge Noiraud
• Soren Roug
• Stefan Bjork
• Stéphane Charette
• Steve Hall
• Steve Swales

• Tim Allen
• Tim Waugh
• Tino Meinen
• Trevor Rhodes
• Wayne Bergeron
• Xing Wang
• Yaakov Selkowitz

If you know of somebody else who should be listed here, please let us
know.

To find more information about GRAMPS, please visit the
GRAMPS Project Web page.

To report a bug or make a suggestion regarding this application or
this manual, use the help menu in GRAMPS, or follow the directions
on this site.

This program is distributed under the terms of the GNU General
Public license as published by the Free Software Foundation; either
version 2 of the License, or (at your option) any later version. A copy
of this license can be found at this link, or in the file COPYING in-
cluded with the source code of this program.
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